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CS – 16  CONTENT MANANGEMENT SYSTEM USING JOOMLA 

NO TOPICS DETAILS MARKS IN 

% 
MIN 

LECT. 
1 Object Oriented 

Programming 
and MVC 
Structure 

1. -Advance Concept of 
OOP 

2. *Class, Properties, Class 
Constants, Auto loading 
Classes, Constructures 
and Destructors, 
Visibility, Object 
Inheritance, Scope 
Resolution Operator(::) 

3. * Static Keyword, Class 
Abstraction, Object 
Interfaces, Namespace, 
Interface, Traits, 
Anonymous classes, 
Overloading, Object 
Iteration, Magic 
Methods, Final 
Keyword, Object 
Cloning, Comparing 
Objects, Type Hinting, 
Late Static Bindings, 
Object Serialization 

4. - Mysql Database 
handling with pdo 
(insert, update, select, 
delete) 

20 12 

2 Introduction 
 
 
 
 
 
 
 
 
 

 - What is Content 
Management System 
(CMS)? 

 - Introduction of Joomla 

 - Joomla Core Features 

 - Advantage & 
Disadvantage of Joomla 
CMS 

 - Understand How 
Joomla Works 

20 12 
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Installation & 
Configuration 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Templates 

- Technical 
Requirements for 
Joomla 
- Installation of Joomla 
- Joomla directory and 
file structure 
- Dashboard overview 
- How to add, edit, 
delete, publish and 
batch process category 
and content 
- User Manager, Groups 
and Access Levels 
- Global Confugurations 
(site, system, server, 
permissions and text 
filters) 
-Joomla Update 
  * Liver Update 
  * Upload & Update 
- Understanding 
Banners, Contacts, 
News Feed and smart 
search 
- Database Structure 
 
- Understanding Joomla 
templates 
- Typical Template 
Directory Structure 
- Template directries 
- Example structure 
with files 
- template files 
- XML Format 
- Basic Details 
- Folder Structure 
- Module Positions 
- Languages 
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- Parameters 

3 Component 
 
 
 
 
 
 
 
 
 
 
 
Modules 
 
 
 
 
 
 
 
 
Plugins 
 
 
 
 
 
 
 
 
 
 
 
 
 
Basic 
Development 
Developing a 

 - What is a Joomla 
Component? 

 - Introduction to MVC 
(Model, View, 
Controller) 

 - Understanding Joomla 
Component Framework 

 - Accessing a joomla 
Component 

 - Joomla MVC Basic 
Directory Structure 

 
- What is joomla 
Modules? 
- How to install and 
publish modules 
- Understanding 
Module Positions 
- Using core joomla 
Modules 
 
- What is plugin? 
- How to install and 
enable plugin 
- Plugin Types ( 
Authentication, 
Captcha, Content, 
Editors, Extensions, 
Finder, Quick Icons, 
System, User) 
- Plugin Events for each 
plugin type 
- custom Plugin Types 
and Events 
- Introduction 
- Development of Basic 
Component 
- Adding a view to the 
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MVC Component site part 
- Adding a menu type to 
the site part 
- Adding a model to the 
site part 
- Adding a variable 
request in the menu 
type 
- Using the database 
- Basic backend 

4 Developing 
Module 
 
 
 
 
 
 
 
 
 
Developing 
Plugin 
 
 
 
 
 
 
Developing 
template 

 - Introduction 

 - File Structure 

 - Creating 
mod_hellowworld.php, 
helper.php, 
tmpl/default.php, 
mod_helloworld.xml 

 - Conclusion 

  

 - Introduction 

 - File structure 

 - Creating the 
installation file 

 - Creating the plugin 

 - Using plugin in your 
code 
 

 - Introduction 

 - setting up a directory 
structure 

 - Creating a basic 
template Details.xml 
file 

 - Creating a basic 
index.php file 

 - 1 Begin 

 - 2 Head 

 - 3 Body Section 

 - 3.1 Module Positions 

20 11 



  SHREE H. N. SHUKLA COLLEGE OF I.T. & MGMT. 
(AFFILIATED TO SAURASHTRA UNIVERSITY) 
 

   2 – Vaishalinagar    3 – Vaishalinagar  
   Nr. Amrapali Railway Crossing  Nr. Amrapali Railway Crossing 
   Raiya Road     Raiya Road 
   Rajkot – 360001    Rajkot - 360001 
   Ph.No–(0281)2440478,2472590   Ph.No–(0281)2471645 
 

 

 

6 

 

 - 4 End 

 - 5 Custom Images 

 - 6 Custom CSS 

 - Testing the template 

 - Packaging the 
template for installation 

 - Conclusion 

5 Advanced 
Development 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Joomla 
Framework 

 Advance Component 
development 

 - Adding language 
management 

 - Adding backend 
actions 

 - Adding decorations to 
the backend 

 - Adding verifications 

 - Adding categories 

 - Adding confuguration 

 - Adding ACL 

 Supporting plugins in 
your component 

 - Background 

 - Joomla Observer 
Implementation 

 - Why Become A 
communicator 

 - Implementation 

 - How to become a 
communicator 

 - How to Trigger Events 

 - Caveats 

 - You are defining an 
API 

 - Load the right plugin 
group 

  

 - What is the joomla 
Framework? 

20 12 
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Joomla 4 and 
Future 
 
 

 - Get the sample 
Application 

 - Why build a joomla 
Framework? 

 What is the Framework 
good for? 

 -Framework Architectur 

 -What does the joomla 
Framework mean for 
you? 

 - Why should i consider 
using the joomla 
Framework? 

 - I know php already 
why should u use this 
Framework? 

 - As a joomla CMS User 
how will i be affected? 

  

 - What is joomla 4 
- Why the trans 
formation in joomla 4? 
- Improvements in 
Joomla admin workflow 
- An evolution in Joomla 
code 
- Orthogonal 
Component Structure 
- Strict MVC 
Implementation 
- Frontend and Backend 
Template 
Improvements using 
Bootstrap 4. 
- Joomla 4 and Joomla 
Framework 

TOTAL  100 60 
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Unit – 1 

Object Oriented Programming and MVC Structure 
 

Q.1 Explain PHP Object oriented Programming         Marks - 3 
Object oriented Programming is a kind of Programming approach in which programmer defines not 
only the data type of data structure, but also defines the types of operation that can be applied to 
the data structure.  
That makes building complex modular and reusable application easily. 

PHP Object Oriented strategy offers mainly these advantages:- 
1. Easier to understand: Object oriented approach makes it possible to think of programs in terms Of 

everyday objects. 
2. Reusability: You frequently need the same types of data in different places in the same application. 

For example a school management application that manages the student's details, attendance, 
result and others. So you can create a student class and access anywhere you want to use this class 
data member and member function.  

3. Improved Reliability: Object oriented code is easily expanded and modified. 
4. Easy to Maintenance: Object oriented code is easier to maintain because it follows somewhat strict 

coding conventions and is written in a self-explanatory format.  
5. Efficiency: The object oriented Programming approach is originally developed for better efficiency 

and ease of the development process.  

PHP and OOP 
PHP offers general object-oriented features, it is not yet a full-featured Object oriented 
Programming language, like C++ and Java. 
 

Q.2  What is class ?          Marks - 2 
Fundamental feature of OOP is the class. 
Class, Sophisticated ‘variable types’. 
Class is a programmer-defined data type, which includes local functions as well as local data. You 
can think of a class as a template for making many instances (an instance variable is 
a variable defined in a class (i.e. a member variable ), for which each instantiated object of the class 
has a separate copy, or instance.) of the same kind (or class) of object. 
A class may contain its own constants, variables (called "properties"), and functions (called 
"methods"). 

https://en.wikipedia.org/wiki/Variable_(programming)
https://en.wikipedia.org/wiki/Member_variable
https://en.wikipedia.org/wiki/Object_(computer_science)
http://php.net/manual/en/language.oop5.constants.php
http://php.net/manual/en/language.oop5.properties.php
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Data variables(data members) and functions(methods) are wrapped up in a class.  Collectively, 
data members and methods are referred to as class members. 
An instance of a class is known as an object. 
 

Syntax: 
 class classname 

{ 
  Variable declaration  
  Function definition  
 } 
A class definition always begins with the keyword ‘class’ followed by an identifier that represents 
the name of the class. 
These are followed by a pair of curly braces ({}) that contains the members of the class. 
The class name can be any valid label, provided it is not a PHP reserved word. A valid class name 
starts with a letter or underscore, followed by any number of letters, numbers, or underscores. 

Defining a new class named Subject 
class Subject 

{ 

} 

Adding Method 
The Demo class isn't particularly useful if it isn't able to do anything. 

<?php  

 classSubject 
 { 

   function SubjectName() { 

    echo "CS-16 : Web Development using Joomla! CMS";} 

  }  

?> 

 

Q.3 What is Object?          Marks - 2 
Objects, which are running instances of a class and contain all the internal data and state 
information needed for your application to function. 
An individual instance of the data structure defined by a class.  
Objects are also known as instance. 
Once a class has been created, any number of object instances of that class can be created. 

Instantiating a class using new keyword :$obj=new subject(); 

http://php.net/manual/en/reserved.php
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To invoke methods: Object->method(); 
 
 
 
 

Object Instantiation 

Example : 1 

<?php 
echo "example of class<br>"; 
class subject 
{ 
 function SubjectName(){ 
  echo "CS-16 : Web Development using Joomla! CMS";} 
} 
//outside the class definition 
$obj=new subject; //an object of type subject 
$obj->SubjectName(); 

?> 

The 'new' keyword 

To create an object out of a class, you need to use the 'new' keyword. 
When creating/instantiating a class, you can optionally add brackets to the classname. 
 

Q.4 What is Properties ?          Marks - 2 
Class member variables are called "properties".  
You may also see them referred to using other terms such as "attributes" or "fields".  
They are defined by using one of the keywords public, protected, or private, followed by a normal 
variable declaration. 
This declaration may include an initialization, but this initialization must be able to be evaluated at 
compile time and must not depend on run-time information in order to be evaluated. 

The '$this' variable 
You probably noticed this line of code: $this->name = $new_name 
The $this is a built-in variable (built into all objects) which points to the currentobject or in other 
words, $this is a special self-referencing variable.  
You use $this to access properties and to call other methods of the current class. 
function get_name()  
{ 

return $this->name; 
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} 
$this as a special OO PHP keyword. When PHP comes across $this, the PHP engine knows what to 
do. 
 
 
 

Example :2 

<?php 
echo "Adding Property <br>"; 
class subject 
{ 
 var $sub; 
 function SubjectName($sub) { 
  $this->sub=$sub; } 
 function PrintData() { 
  echo $this->sub;} 
} 
//outside the class definition 
$obj=new subject; //an object of type subject 
$obj->SubjectName("CS-16 : Web Development using Joomla! CMS"); 
$obj->PrintData(); 

?> 

Example:3 

<?php 

echo "example of class"; 
class student 
{ 
 public $text = "<br>Advance Concept of OOP"; 
  

function PrintData() 
 { 
  echo $this->text; 
 } 
} 
//outside the class definition 
$obj=new student; //an object of type student 
$obj->display(); 

Method 

Data Member 
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?> 

 

Q.5 Explain Class Constants.         Marks - 2 
A constant is, just like the name implies, a variable that can never be changed. When you declare a 
constant, you assign a value to it, and after that, the value will never change. 
Constants differ from normal variables in that you don't use the $ symbol to declare or use them. 
Declared with the const keyword. 
Value must be supplied with the declaration. 
Accessed with scope operator (::) 
Can be overridden by child classes. 
The default visibility of class constant is public. 
The value must be a constant expression, not (for example) a variable, a property, a result of a 
mathematical operation, or a function call. 
<?php 

class User 
{ 
 const DefaultUserName='CCSIT'; 
} 
echo 'The default user name is  : '.User::DefaultUserName;   ?> 

You can see, it's much like declaring variables, except there is no access modifier - a constant is 
always publically available.  
As required, we immediately assign a value to the constants, which will then stay the same all 
through execution of the script.  
 

Q.6 Explain Autoloading Classes.         Marks - 5 
It is good practice to keep each PHP class in a separated file and all class files in a folder 
named classes.  
In addition, the name of the class should be used to name the file for example if you have 
a Student class, the file name should be Student.php. 
Before using a class you need to load it in your script file using PHP include file function such 
as  require_once() as follows: 

o require_once("classes/Student.php"); 
o $objStud = new Student; 

When the number of classes grows, it is quite tedious to call  require_once() function everywhere 
you use the classes. Fortunately, PHP provides a mechanism that allows you to load class files 
automatically whenever you try to create an object from a non-existent class in the context of the 
current script file. 

http://www.zentut.com/php-tutorial/php-objects-and-classes/
http://www.zentut.com/php-tutorial/php-include-file/
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PHP will call  __autoload() function automatically whenever you create an object from a non-
existent class. To load class files automatically, you need to implement the __autoload() function 
somewhere in your web application as follows: 

<?php 
function __autoload($className) { 

require_once("classes/$className.php");} 
?> 

Whenever you create an object from a non-existent class, PHP looks into the  ./classes folder and 
load the corresponding class file using the  require_once() function. 
From now on, you don’t have to call require_once() function every time you use the class, which is 
very useful. 

Notice that if PHP cannot find the __autoload() function or if the  __autoload() function failed to load 
the class files, you will get an error message. 

Example # 1[Autoload Class] 
college.php [class file] 
<?php 
class college 
{ 
 public $collegeCode, $collegeName; 
 functionsetDisplay($code, $name) { 
  $this->collegeCode=$code; 
  $this->collegeName=$name; 
  echo "<br>College Code : ".$this->collegeCode; 
  echo "<br>College Name : ".$this->collegeName;} 
} 
class Address 
{ 
 public $add; 
 function __construct($add){ 
  $this->add=$add;} 
 public function getDescription(){ 
  return $this->add;} 
} 
?> 
AutoloadingClass.php 
<?php 
function__autoload($class_name) { 
require_once $class_name . '.php'; 
} 
 

Class definition comes 

from another file. 
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$objCollege = new college; 
$objCollege->setDisplay("15035", "CCSIT"); 
$objAddress = new Address("Green City<br>Junagadh"); 
echo "<p>Address: " . $objAddress->getDescription() . "</p>"; 
?> 
 
 
 
 

Example # 2 

myClass1.php 

<?php 
class myClass1 
{ 
 function __construct() { 
  echo "<br>CS-16 Web Development Using Joomla!<u>CMS</u>"; } 
} 

myClass2.php 

<?php 
class myClass2 
{ 
 function __construct() { 
  echo "<br><u>CMS</u> means Content Management System";} 
} 
 

Autoloadingclass.php 
<?php 

spl_autoload_register(function ($class_name)  
{ 

include $class_name . '.php'; 
}) 
$obj1  = new MyClass1();$obj2 = new MyClass2(); 

?> 

 

Q.7 Explain Constructors and Destructors.       Marks - 5 
 
Constructors: 
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All objects can have a special built-in method called a 'constructor'.  

Constructors allow you to initialize your object's properties (give your properties values,) when you 
instantiate (create) an object. 

Note: If you create a __construct() function (it is your choice,) PHP will automatically call the 
__construct() method/function when you create an object from your class. 

The 'construct' method starts with two underscores(__) and the word 'construct'. 

You 'feed' the constructor method by providing a list of arguments (like a function) after the class 
name. 

A constructor is a function that does initializations when the class is instantiated. 

Each class can have only one constructor. 

 

 

 

Syntax:  void __construct ([ mixed $args = "" [, $... ]] ) 
<?php 
 class Demo 
 { 
  function __construct() { } 
 } 
?> 

Example# 1[Without Parameter] 
<?php 

class Demo 
{ 
 function __construct() { 
  echo "Constructor Called";} 
} 
$objDemo=new Demo(); 

?> 

Example: 2 [With Parameter] 
<?php 

class Demo 
{ 
 function __construct($name) { 
  echo "My College is : ".$name;} 
} 

http://php.net/manual/en/language.pseudo-types.php#language.types.mixed
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$objDemo=new Demo("CCSIT");  ?> 

Example: 3 [Default Argument] 
<?php 

class Demo 
{ 
 function __construct($name="CCSIT"){ 
  echo "My College is : ".$name;} 
} 
$objDemo=new Demo();//$objDemo=new Demo("CCSIT-Junagadh"); 

?> 
Instantiating a class without parameters will make use of the default values. 

Note: Parent constructors are not called implicitly if the child class defines a constructor. In order to 
run a parent constructor, a call to parent::__construct() within the child constructor is required. If the 
child does not define a constructor then it may be inherited from the parent class just like a normal 
class method. 

 

<?php 
class BaseClass  
{ 

function __construct() { 
print "<br>In BaseClass constructor\n";   } 

} 
class SubClass extends BaseClass { 
function __construct() { 
       parent::__construct(); 
       print "<br>In SubClass constructor\n";  } 
} 
class OtherSubClass extends BaseClass { 
    // inherits BaseClass's constructor 
} 
// In BaseClass constructor 
$obj = new BaseClass(); 
// In BaseClass constructor then In SubClass constructor 
$obj = new SubClass(); 
// In BaseClass constructor 
$obj = new OtherSubClass(); 

?> 
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Destructor 
Destructors are automatically called when script is shutting down. 

Destructor is Called when objects are destroyed – free up memory. 

Use function __destruct to create destructor in PHP. 

Each class can have only one destructor. 

Syntax: 
void __destruct ( void ) 

<?php 
 class Demo 
 { 
  function __destruct() 
  { 
  } 
 } 

?> 
 

Example:  
<?php 

class Demo 
{ 
 function __construct($name="CCSIT"){ 
  echo "My College is : ".$name;} 
 function __destruct ()  { 
  echo "<br>freeing up memory, destroying this object... "; } 
} 
//$objDemo=new Demo(); 
$objDemo=new Demo("CCSIT-Junagadh"); 

?> 
Note: Like constructors, parent destructors will not be called implicitly by the engine. In order to run a 

parent destructor, one would have to explicitly call parent::__destruct() in the destructor body. 
Also like constructors, a child class may inherit the parent's destructor if it does not implement 
one itself. 

<?php 
class BaseClass 
{ 
 public $college="CCSIT"; 
 function __construct() { 
  echo $this->college;} 
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 function __destruct(){ 
  echo '<br>Base Class object Destroyed :';} 
} 
class subClass extends BaseClass 
{ 
 function __construct() { 
  parent::__construct(); 
  echo '<br>Sub Class Constructor';} 
 function __destruct(){ 
  parent::__destruct(); 
  echo '<br>Sub Class Destruct';} 
} 
$objBase=new BaseClass(); $objSub=new subClass(); 

?> 
 

Q.8 Explain Visibility : [Visibility of a Method or Data Member OR Access Specifiers]  Marks - 5 
The visibility of a property, a method or a constant can be defined by prefixing the declaration with 
the keywords public, protected or private. 

There are three different levels of visibility that a member variable or method can have : 

i. Public 

ii. Private 

iii. Protected 

public–  
class members can be accessed both within and outside the class. 

class MyClassName 
{ 

public $strFirstName; 
public function getFirstName() 
{ 
} 

} 
By default, without the access specifiers, class members are defined public. 

Example: 
<?php 
class Demo 
{ 
 public $DefaultUser; 
 function getUser() { 
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  $this->DefaultUser="CCSIT"; } 
 function callUser() { 
  echo $this->DefaultUser; } 
} 
$objDemo=new Demo();//$objDemo->getUser(); 
$objDemo->DefaultUser="CCSIT";$objDemo->callUser(); 
?> 

private–  
Members declared as private may only be accessed by the class that defines the member.. 

<?php 
class Demo 
{ 
 private $DefaultUser; 
 private function getUser() { 
  $this->DefaultUser="CCSIT"; } 
 function callUser() { 
  $this->getUser(); 
  echo $this->DefaultUser; } 
} 
$objDemo=new Demo();//$objDemo->getUser(); //fatal error because of private 
//$objDemo->DefaultUser="CCSIT"; //fatal error because private 
$objDemo->callUser(); 
?> 

protected –  
Members declared protected can be accessed only within the class itself and by inheriting classes. 

Class MyClassName 
{ 

protected $strFirstName; 
protected function getFirstName() { 
} 

} 
Inherited protected class members – accessible inside a derived class. 

Visibility of protected class members outside the class definition – protected class members are 
inaccessible. 

<?php 
class Main 
{ 
 protected $DefaultUser="CCSIT"; 
 function getUser() { 
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  $this->DefaultUser="CCSIT-JND"; } 
} 
class Derived extends Main 
{ 
 function callUser() { 
  echo $this->DefaultUser; } 
} 

$objDerived=new Derived(); 
#echo $objDerived->DefaultUser;//Fatal error: Cannot access protected property 

Derived::$DefaultUser 
echo "<br>"; 
$objDerived->getUser();$objDerived->callUser(); 

?> 
Property Visibility 

Class properties must be defined as public, private, or protected. If declared using var, the property 
will be defined as public. 

Example:[ Property Declaration] 
<?php 

# Define MyClass 

class MyClass 

{ 

public $public = 'Public'; 

protected $protected = 'Protected'; 

private $private = 'Private'; 

function printHello(){ 

echo $this->public; 

echo $this->protected; 

echo $this->private; }  

} 

$obj = new MyClass(); 

echo $obj->public; // Works 

//echo $obj->protected; // Fatal Error 

//echo $obj->private; // Fatal Error 

$obj->printHello(); // Shows Public, Protected and Private 

# Define MyClass2 

class MyClass2 extends MyClass 
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{    // We can redeclare the public and protected properties, but not private 

public $public = 'Public2'; 

protected $protected = 'Protected2'; 

functionprintHello()   { 

echo $this->public; 

echo $this->protected; 

echo $this->private; //Notice: Undefined property: MyClass2::$private    } 

} 

$obj2 = new MyClass2(); 

echo $obj2->public; // Works 

#echo $obj2->protected; // Fatal Error 

#echo $obj2->private; // Undefined 

$obj2->printHello(); // Shows Public2, Protected2, Undefined ?> 

 
Method Visibility 

Class methods may be defined as public, private, or protected. Methods declared without any 
explicit visibility keyword are defined as public. 

Example: [ Method Declaration] 
<?php 

#Define MyClass 

class MyClass 

{ 

# Declare a public constructor 

public function __construct() { } 

# Declare a public method 

public function MyPublic() { 

  echo '<br>Public Method'; } 

# Declare a protected method 

protected function MyProtected() { 

  echo '<br>Protected Method'; } 

# Declare a private method 

private function MyPrivate() { 

  echo '<br>Private Method'; } 

#This is public 
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function Test() { 

          $this->MyPublic(); 

         $this->MyProtected(); 

          $this->MyPrivate();} 

} 

$myclass = new MyClass; 

$myclass->MyPublic(); // Works 

#$myclass->MyProtected();//Fatal Error:Call to protected method MyClass::MyProtected() 
from context 

#$myclass->MyPrivate(); //Fatal Error: Call to private method MyClass::MyPrivate() from 
context 

$myclass->Test(); // Public, Protected and Private work 

?> 

 

Q.9 Explain Object Inheritance.         Marks - 3 
Inheritance is nothing but a design principle in OOP.  

By implementing inheritance you can inherit (or get) all properties and methods of one class to 
another class. 

The class who inherit feature of another class known as child class (Derived Class).The class which 
is being inherited is known as parent class(Base Class). 

PHP supports two types of inheritance : Simple & Multi-level. 

In multilevel inheritance child can get some property of from grandparent class also. 

Example: 1 [Simple Inheritance] 
<?php 

class BaseClass 
{ 
 function BaseTest() { 
  echo "Wel Come @ 'CCSIT' College"; } 
} 
class DerivedClass extends BaseClass 
{ 
 function DerivedTest() { 
  echo '<br>Green city, Junagadh';} 
} 
$ObjDerived=new DerivedClass(); 
$ObjDerived->BaseTest();$ObjDerived->DerivedTest(); 



  SHREE H. N. SHUKLA COLLEGE OF I.T. & MGMT. 
(AFFILIATED TO SAURASHTRA UNIVERSITY) 
 

   2 – Vaishalinagar    3 – Vaishalinagar  
   Nr. Amrapali Railway Crossing  Nr. Amrapali Railway Crossing 
   Raiya Road     Raiya Road 
   Rajkot – 360001    Rajkot - 360001 
   Ph.No–(0281)2440478,2472590   Ph.No–(0281)2471645 
 

 

 

23 

 

?> 

Example : 2 [Multi-level Inheritance] 
<?php 

class grandParent 
{ 
 function Test1(){ 
  echo "<br>Welcome @ 'CCSIT' College";} 
} 
class Mparent extends grandParent 
{ 
 function Test2() {  
  echo "<br>Green City,<br>Nr. Chobari Railway Crossing"; } 
} 
class child extends Mparent 
{ 
 function Test3(){ 

echo "<br>Mobile : 92280 06940,<br>E-mail : ccsit_junagadh@yahoo.co.in<br>Website : 
https://www.ccsit.co.in"; } 

} 
$objChild=new child(); 
$objChild->Test1();$objChild->Test2();$objChild->Test3(); 

?> 

 

Q.10 Explain Scope Resolution Operator (::)       Marks - 3 
The Scope Resolution Operator or in simpler terms, the double colon (::), is a token that allows 
access to static, constant, and overridden properties or methods of a class. 

When referencing these items from outside the class definition, use the name of the class. 

Example :1 [:: from outside the class definition] 

<?php 

class Demo 
{ 
 constDefaultUser="CCSIT"; 
} 
echo Demo::DefaultUser; 
 
$objDemo=new Demo();echo $objDemo::DefaultUser; 
 
$myClass="Demo";echo $myClass::DefaultUser; 

http://php.net/manual/en/language.oop5.static.php
http://php.net/manual/en/language.oop5.constants.php
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?> 

Example :2 [:: from inside the class definition (using self keyword)] 

<?php 

class Demo 
{ 
 const DefaultUser="CCSIT"; 
 function Test() { 
  echo self::DefaultUser;} 
} 
$objDemo=new Demo();$objDemo->Test(); 

?> 

 

 

Example :3  [:: from inside the class definition (using parent keyword)] 

<?php 

class BaseClass 
{ 
 constDefaultUser="CCSIT"; 
 function Test() { 
  echo self::DefaultUser;} 
} 
class DerivedClass extends BaseClass 
{ 
 function DerivedTest() { 
  echo parent::DefaultUser; //calling parent’s property 
  parent::Test(); //calling parent’s method} 
} 
$objDerived=new DerivedClass(); 
$objDerived->DerivedTest(); 

?> 

Example :4   

A class constant, class property (static), and class function (static) can all share the same name and 
be accessed using the double-colon(::). 

<?php 

class A  
{ 
public static $B = '1'; # Static class variable. 
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const B = '2'; # Class constant. 
public static function B() {  

# Static class function. 
return '3';  }    

} 
echo A::$B . A::B . A::B(); # Outputs: 123 

?> 

 

Q.11 Explain Static keyword         Marks - 2 
Declaring class properties or methods as static makes them accessible without needing an 
instantiation of the class. A property declared as static cannot be accessed with an instantiated 
class object. 

 

 

Static methods 

Because static methods are callable without an instance of the object created, the pseudo-variable 
$this is not available inside the method declared as static. 

 

Example #1 [Static method example] 

<?php 

class Demo 
{ 
 static function Test() { 
  echo "<br>Static Method Example"; } 
} 
echo Demo::Test(); 
$objDemo=new Demo(); 
$objDemo->Test();$objDemo::Test(); 

?> 

Static properties 

Static properties cannot be accessed through the object using the arrow operator ->. 

Like any other PHP static variable, static properties may only be initialized using a literal or constant 
or expression. 

<?php 

class Demo 
{ 
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 static $DefaultUser="CCSIT"; 
} 
echo Demo::$DefaultUser; 
$objDemo=new Demo(); 
echo '<br>'.$objDemo::$DefaultUser; 
//echo $objDemo->DefaultUser; //cannot use -> operator  

?> 

 

Q.12 Explain Class Abstraction.         Marks - 3 
Abstract classes are those classes which cannot be directly initialized or in other word we can say 
that you cannot create object of abstract classes. 

Abstract classes always created for inheritance purpose. 

The class must be inherited. 

You can create abstract classes in PHP using abstract keyword.  

Abstract class must have at least one abstract method. 

Methods defined as abstract simply declare the method's signature - they cannot define the 
implementation. 

You can only inherit abstract class in your child class. 

Example #1 [abstract class] 

<?php 
abstract class Demo 
{ 

function Test(){ 
return "CCSIT";} 

} 
$objDemo=new Demo();//fatal error: Cannot instantiate abstract class Demo 

?> 
 

Example #2 [abstract class (in inheritance)] 

<?php 
abstract class BaseClass 
{ 
 function BaseTest(){ 
  return "College Code :15035";} 
} 
class DerivedClass extends BaseClass 
{ 
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 function DerivedTest() { 
  return "<br>Name : CCSIT";} 
} 
$objDerived=new DerivedClass(); 
echo $objDerived->BaseTest(); 
echo $objDerived->DerivedTest(); 

?> 
 

Implementation of abstract method 

As we know that abstract functions are those functions of abstract class which is only defined.  

It will be declared in your child class.  

You can create any method abstract using keyword abstract.  

You can only create abstract method either in abstract class or interface.  

When inheriting from an abstract class, all methods marked abstract in the parent's class 
declaration must be defined by the child; additionally, these methods must be defined with the 
same (or a less restricted) visibility.  

For example, if the abstract method is defined as protected, the function implementation must be 
defined as either protected or public, but not private.  

Furthermore the signatures of the methods must match, i.e. the type hints and the number of 
required arguments must be the same.  

For example, if the child class defines an optional argument, where the abstract method's signature 
does not, there is no conflict in the signature.  

Only an abstract classes can have an abstract method normal classes cannot have abstract 
methods. 

You can declare abstract and non - abstract methods within an abstract class. 

Example #3 [abstract Method] 

 
<?php 

abstract class BaseClass 
{ 
 Abstract protected function Test($code,$subject); 
} 
Class DerivedClass extends BaseClass 
{ 
 protected function Test($code,$subject){ 
  echo "$code $subject";} 
} 

http://php.net/manual/en/language.oop5.visibility.php
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Class OtherClass extends DerivedClass 
{ 
 function callDerived(){ 
  $this->Test("CS-16","Web Development Using Joomla!CMS");} 
} 
$objOther=new OtherClass();$objOther->callDerived(); 

?> 
In class BaseClass we have defined an abstract function Test().  

Now when we have inherited class BaseClass then declared function Test().  

Note: If you have an abstract method in your abstract class then once you inherit your abstract class 
then it is necessary to declare your abstract method. If you will not declare your abstract method 
then PHP will throw error in that case. 

 

Q.13 Explain Object Interfaces.         Marks - 5 
Object interfaces allow you to create code which specifies which methods a class must implement, 
without having to define how these methods are handled. 

Interfaces are defined in the same way as a class, but with the interface keyword replacing the 
class keyword and without any of the methods having their contents defined. 

All methods declared in an interface must be public; this is the nature of an interface. 

Interfaces works same as abstract classes, in the interface they declare a consistent set of methods 
that classes must implement. In the case of interface parent-child relationship does not exist. A 
class can access the properties of the interface with the help of implements keyword. 

Note: At the same time you can extend class also. 

Suppose an interface has two methods, and another class that implements the interface must have 
given the body. 

Syntax 
<?php 

  Interface NameOfInterface 

{ 

Name of method with the number of arguments 

………………………. 

………………………. 

} 

 ?> 

Example #1 [Interface] 
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<?php 
Interface MyFirstInterface 
{ 

Public function FirstMethod( $name); 
Public function SecondMethod( $name, $roll); 

} 
?> 

Some Point about Interface 

1. You cannot contain properties, only the methods declaration allowed in case of interface. 

2. All method must be public in case of interface. 

3. You can then make a class that implements an interface using the implements keyword. 

Example #2 [Class with Interface] 

<?php 
Class FirstClass implements MyFirstInterface 
{ 

Public function FirstMethod ( $name){ 
//Method implementation here} 

Public function SecondMethod ( $name, $roll) { 
//Method implementation here } 

} 
 ?> 

Example #3 [Two Interface Implementation] 

You can implement more than one interfaces with the help of comma. 

<?php 
  Class FirstClass implements MyFIrstInterface, MySecondInterface 

{ 
// all Methods implementation from MyFIrstInterface 
// and MySecondInterface. 

}  
?> 

  <?php 
  Interface MyInterface 

{ publicfunctionmyMethod( $name);} 
  Interface MySecondInterface 

{publicfunctionmySecondMethod( $name);} 
Class MyFirstClass implements MyInterface,MySecondInterface 
{ 

Public function myMethod( $name1){ 
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echo"$name1";} 
  Public function mySecondMethod( $name1) { 

echo"$name1"; } 
} 
$firstObj= new MyFirstClass; 
$firstObj->myMethod("John"); $firstObj->mySecondMethod("Brown"); 
?> 
 
 

Example #3 [ Multiple Interface] 

You can also extends mutiple interface using extends keyword in PHP. 

<?php 
  Interface first 

{Public function set();} 
Interface second extends first 

{publicfunctiondisplay();} 
Class Computer implements second 
{ 

Public function set(){ 
echo "First interface method<br>";} 

Public function display(){ 
echo "Second interface method";} 

} 
$obj=new Computer(); $obj->set(); $obj->display(); 

?> 
Implements 

To implement an interface, the implements operator is used. All methods in the interface must be 
implemented within a class; failure to do so will result in a fatal error.  

Classes may implement more than one interface if desired by separating each interface with a 
comma. 

Example #4 [Interface example] 

<?php 
Interface iTest 

{ public function GetVal($a,$b); 
  public function SetVal();} 
class BaseClass implements iTest 
{ 
 public $a,$b; 
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 public function GetVal($x,$y){ 
  $this->a=$x; 
  $this->b=$y;} 
 public function SetVal(){ 
  echo $this->a+$this->b;} 
} 
$objBase=new BaseClass(); $objBase->GetVal(100,200); $objBase->SetVal(); 
?> 

Example #5 [Extendable Interface] 

<?php 
Interface iMain 

{ public function SubjectCode();} 
Interface iSub extends iMain 

{ public function SubjectName();} 
Class BaseClass implements iSub 
{ 
 public function SubjectCode(){ 
  echo "Subject Code : - CS-16";} 
 public function SubjectName(){ 
  echo "<br>Subject Name : - Web Development using Joomla! CMS";} 
} 
$objBase=new BaseClass(); $objBase->SubjectCode(); $objBase->SubjectName(); 

?> 
 
 

Example #6 [Multiple Interface Inheritance] 

<?php 
Interface iCode 

{ public function SubjectCode();} 
Interface iSubject 

{ public function SubjectName();} 
Class BaseClass implements iCode,iSubject 
{ 
 public function SubjectCode(){ 
  echo "Subject Code : - CS-16";} 
 public function SubjectName(){ 
  echo "<br>Subject Name : - Web Development using Joomla! CMS";} 
} 
$objBase=new BaseClass(); $objBase->SubjectCode(); $objBase->SubjectName(); 
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?> 
Example #4 [Interfaces with constants] 

<?php 
interface a 
 { const b = 'Interface constant';} 
// Prints: Interface constant 
echo a::b; 
// This will however not work because it's not allowed to override constants. 
class b implements a 

{ const b = 'Class constant';} 
?> 
 

Q.14 Difference between Interface & Abstract Class in PHP.     Marks - 3 

1. Every method must be abstract in case of interface while in case of abstract class you can keep 
non abstract method. 

2. You can keep public as well as protected method in case of abstract class while in case of 
interface you can keep only public method. 

3. In case of interface you can only define a standard that means declare function while in case of 
abstract class you can define standard as well as declare functions. 

2. Namespace 
Namespaces are a way of encapsulating items.  

Namespaces are basically a way of organizing your PHP classes and preventing from any kind of code 
conflicts.  

This can be seen as an abstract concept in many places.  

In the PHP world, namespaces are designed to solve two problems that authors of libraries and 
applications encounter when creating re-usable code elements such as classes or functions: 

In PHP you can’t have two classes that share the same name. They have to be unique. The issue with this 
restriction is that if you are using a third party library which has a class named User, then you can’t create 
your own class also called User.  

PHP namespaces allow us to circumvent this issue, in fact we can have as many User classes as we like. Not 
only that, but we can use namespaces to contain our similar code into neat little packages, or even to show 
ownership. 

 

 

In nm1 folder where student.php file exists as follow: 

<?php 
namespace nm1; 
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class student 
{ 
 var $rno,$name,$course,$sem; 
 function __construct($rno,$name,$course,$sem){ 
  $this->rno=$rno; 
  $this->name=$name; 
  $this->course=$course; 
  $this->sem=$sem;} 
 function printData(){ 
  echo '<br>Roll : '.$this->rno; 
  echo '<br>Name : '.$this->name; 
  echo '<br>Course & Sem : '.$this->course.'-'.$this->sem;} 
} 

In the above example we are creating a new class called student  inside of the nm1 namespace.  

If we didn't use a namespace and we had another class with the name of 'student' included our application 
we would get an error stating we cannot redeclare class.  

Luckily namespaces can solve this issue.  

So we could create another class like this: 

In folder nm2 where also student.php file exists as follow: 

<?php 
namespace nm2; 
class student 
{ 
 var $cpp,$oracle,$sad,$joomla; 
 function __construct($cpp,$oracle,$sad,$joomla){ 
  $this->cpp=$cpp; 
  $this->oracle=$oracle; 
  $this->sad=$sad; 
  $this->joomla=$joomla;} 
 function printData(){ 
  echo '<br>CPP : '.$this->cpp; 
  echo '<br>Oracle : '.$this->oracle; 
  echo '<br>SAD : '.$this->sad; 
  echo '<br>Joomla : '.$this->joomla;} 
} 

The following file with the above file  
 

<?php 
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// require both of our student classes 
require('nm1/student.php'); 
require('nm2/student.php'); 
// create a new student in the nm1 namespace 

$obj=new nm1\student(1,"krishna","BCA",1); 
$obj->printData(); 

// create a new student in the nm2 namespace 
$obj=new nm2\student(60,60,60,60); 
$obj->printData(); 

?> 
Now, if we included both files in our application we can easily distinguish which student class we want to 
use. As an example here's some code of how we would use the ninja classes: 

Both of these classes are different and probably have different functionality, so namespaces allows us to 
use the same class names and differentiating them by their namespaces. 

You can also use the PHP use function to make your code more readable.  

 

Q.15 Explain Traits.           Marks - 3 
In PHP trait is the method of code re-usability. 

PHP is single inheritance programming language. 

The structure of PHP traits is almost matched with a PHP class but here we group the re-usable 
methods.  

You can use that trait in those class needs to have the feature of the traits function. 

if you have a group of the method which is same in the different class then you can club it into PHP 
Traits. 

You are free to use access modifier also in your PHP traits. 

Example #1 [ trait] 
<?php 

trait college 
{ 
 public function message(){ 
  echo "CCSIT-Junagadh";} 
} 
class test 
{ 
 use college; 
} 
$obj=new test();$obj->message(); 

http://www.techflirt.com/tutorials/oop-in-php/classes-and-objects-php.html


  SHREE H. N. SHUKLA COLLEGE OF I.T. & MGMT. 
(AFFILIATED TO SAURASHTRA UNIVERSITY) 
 

   2 – Vaishalinagar    3 – Vaishalinagar  
   Nr. Amrapali Railway Crossing  Nr. Amrapali Railway Crossing 
   Raiya Road     Raiya Road 
   Rajkot – 360001    Rajkot - 360001 
   Ph.No–(0281)2440478,2472590   Ph.No–(0281)2471645 
 

 

 

35 

 

?> 
 
Example #2 [ multiple traits in a single PHP class] 

<?php 
trait CollegeInfo 
{ 
 function Address(){ 
  echo "<b>College : </b><br>CCSIT<br>Green City<br>Junagadh"; } 
} 
trait CourseInfo 
{ 
 function Course(){ 
  echo "<br><b>Courses Offered : </b><br>B.Sc.(IT)<br>B.C.A.<br>M.Sc.(IT)";} 
} 
class Test 
{ 
 use CollegeInfo, CourseInfo; 
} 
$obj=new Test;$obj->Address();$obj->Course(); 

?> 
 
Example # 3[use one trait in another] 

<?php 
trait CollegeInfo 
{ 
 function Address(){ 
  echo "<b>College : </b><br>CCSIT<br>Green City<br>Junagadh"; } 
} 
trait CourseInfo 
{ 
 use CollegeInfo; 
 function Course(){ 
  echo "<br><b>Courses Offered : </b><br>B.Sc.(IT)<br>B.C.A.<br>M.Sc.(IT)";} 
} 
class Test 
{ 
 use CourseInfo; 
} 
$obj=new Test; 
$obj->Address(); 
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$obj->Course(); 
?> 
 

Example #4 [Trait in Inheritance] 
<?php 
class main 
{ 
 function f1(){ 
  echo '<br>Parent Class';} 
} 
trait test 
{ 
 function t1() { 
  echo '<br>Trait Info';} 
} 
class derived extends main 
{ 
 use test; 
 function f2(){ 
  echo '<br>Child Class Info';} 
} 
$obj=new derived; 
$obj->f1();$obj->f2();$obj->t1(); 
?> 
 
 

Example #5 [Precedence in traits] 
If the same function found on multiple levels(for example in the child class, base class, and trait) 
then there is some specific precedence order defined in php for choosing the function 

<?php 
class main 
{ 
 function f1(){ 
  echo '<br>Parent Class';} 
} 
trait test 
{ 
 function f1(){ 
  echo '<br>Trait Info';} 
} 
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class derived extends main 
{ 
 use test; 
 function f1(){ 
  echo '<br>Child Class Info';} 
} 
$obj=new derived; 
$obj->f1();//child,trait,parent 
?> 
 

Q.16 Explain Anonymous Classes.         Marks - 2 
 

Anonymous classes are the classes which are defined without any name.  

We can define an anonymous class using keyword ‘new class’.  

This class can replace a full class definition. 

 

Q.17 Explain Overloading.          Marks - 3 
Overloading in PHP provides the means to dynamically create members and methods via set of 
"magical" methods 

1. Invoked with interacting with members or methods that have not been declared or are not 
visible in the current scope 

2. All of the magic methods must be declared as public 

3. None of the magic functions can be called with arguments, passed by reference 

All overloading methods are invoked when accessing variable or method that is not declared or is 
inaccessible 

o __set($name, $value) – when writing 

o __get ($name) –when reading 

o __isset ($name) – when calling isset() function 

o __unset ($name) – when calling unset() function 

o __call ($name, $arguments) - when calling a method 

o __callStatic ($name, $arguments) – when calling a method in a static context 

Must always be declared as static 

PHP "overloading" is a lot different from most languages "overloading" 

Usually it means the ability to declare two methods with different sets of parameters but same 
names 
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overriding 
When a class inherits another, it can declare methods that override parent class methods 
Method names are the same Parameters may differ 

<?php 
class ParentClass 
{ 
 var $r,$area; 
 const PI=3.14; 
 public function funArea(){ 
  $this->r=10; 
  $this->area=self::PI*$this->r*$this->r; 
  echo "Area of Circle : ".$this->area;} 
} 
class child extends ParentClass 
{ 
 var $l,$b; 
 public function funArea(){ 
  echo parent::funarea(); 
  echo '<br>'; 
  $this->l=10; 
  $this->b=20; 
  echo "Area of Rectangle : ".$this->l*$this->b;} 
} 
$objChild=new child; 
$objChild->funArea(); 

?> 
 

Q.18 Explain Object Iteration.         Marks - 3 
PHP provides a way for objects to be defined so it is possible to iterate through a list of items, with, for 
example a foreach statement. By default, all visible properties will be used for the iteration.  

 

 

Example #1 [Simple Iteration] 

<?php 
class Main 
{ 
 var $a="Public"; 
 protected $b="Protected"; 

http://php.net/manual/en/control-structures.foreach.php
http://php.net/manual/en/language.oop5.visibility.php
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 private $c="Private"; 
} 
$obj=new Main; 
foreach($obj as $key=>$value) 
 echo '<br>'.$key."=>".$value; 

?> 
 

Example #2 [Simple Iteration] 

<?php 
class Main 
{ 
 var $a="Public"; 
 protected $b="Protected"; 
 private $c="Private"; 
 function Test() 
 { 
  foreach($this as $key=>$value) 
   echo '<br>'.$key."=>".$value; 
 } 
} 
$obj=new Main; 
$obj->Test(); 

         ?> 
 

Example #3[Iteration Array] 

<?php 
class Main 
{ 
 var $fruit=array('Apple','Banana','Grapes','Guava','Mango'); 
} 
$obj=new Main; 
foreach($obj->fruit as $val) 
echo '<br>'.$val; 
echo '<br>'; 
print_r($obj); 
echo '<br>'; 
print_r($obj->fruit); 
?> 
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Example #4 [Iteration Array] 

<?php 
class Main 
{ 
 var $fruit=array('Apple','Banana','Grapes','Guava','Mango'); 
 function Test() 
 { 
  foreach($this->fruit as $key=>$value) 
   echo '<br>'.$key."=>".$value; 
 } 
} 
$obj=new Main; 
$obj->Test(); 

?> 
 

Example #5  

<?php 
class MyClass{ 
    public $var1 = 'value 1'; 
    public $var2 = 'value 2'; 
    public $var3 = 'value 3'; 
    protected $protected = 'protected var'; 
    private   $private   = 'private var'; 
    function iterateVisible() { 
       echo "MyClass::iterateVisible:\n"; 
       foreach ($this as $key => $value) { 
           print "$key => $value\n"; } 
    } 
} 
$class = new MyClass(); 
foreach($class as $key => $value) { 
    print "$key => $value\n";} 
echo "\n"; 
$class->iterateVisible(); 
?> 

Q.19 Explain Magic Methods.         Marks - 5 
The "magic" methods are ones with special names, starting with two underscores(__), which 
denote methods which will be triggered in response to particular PHP events. 
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Magic methods in PHP are some predefined function by PHP compiler which executes on some 
event. Magic methods starts with prefix __. 

__construct __destruct __get __set __call 

__toString __clone __isset __wakeup __unset 

__invoke __sleep __autoload   

 

1. __construct 

The constructor is a magic method that gets called when the object is instantiated. It is usually 
the first thing in the class declaration but it does not need to be, it a method like any other and 
can be declared anywhere in the class. Constructors also inherit like any other method.  

 

2. __destruct() 

This magic method runs when your object is destroyed. By default, all objects are destroyed 
when the script is finished running. 

 

Example [ __construct and __destruct Magic Method] 

<?php 
//__contructor & __destruct magic method example 
class MagicMethods 
{ 
 function __construct() { 
  echo 'Constructor is called'; } 
 function __destruct() { 
  echo '<br>Destructor is called';} 
} 
$objMagic=new MagicMethods; 

?> 
 

3. __get() 

The __get() method is called whenever you attempt to read a non-existing or private property 
of an object. 

It accepts 1 parameter which is the name of the property you tried accessing. 

 

4. __set() 

The __set() method is called whenever you attempt to write to a non-existing or private 
property of an object. 
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It accepts 2 parameters which is the name and the value of the property you attempted 
creating or updating. 

Example [ __get and __Set Magic Method] 

<?php //__get & __set magic method example 
class magicMethod 
{ 
 function __get($name) { 
  echo $name;} 
 function __set($name,$code){ 
  echo "College Name <u>$name</u> & Code of College <u>$code</u>";} 
} 
$objMagic=new magicMethod(); 
$objMagic->CCSIT; //call __get magic method 
echo '<br>'; 
$objMagic->CCSIT=15035; //call __set magic method 

?> 
 

5. __call() 

This magic method runs when you try using a method that doesn’t exist.  

It accepts 2 parameters which is the name of the method and the parameters you tried passing 
in.  

The parameters are converted into 1 array. 

 

Example [ __call Magic Method] 

<?php //__call Magic Method example 
class magicMethod 
{ 
 function __call($name,$value){ 
  echo "Method Name : $name <br>"; 
  echo print_r($value); } 
} 
$objMagic=new magicMethod; 
$objMagic->getData('CCSIT','Junagadh'); 

?> 
 

6. __toString() 

public string__toString ( void ) 
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This magic method runs when you try echoing out the object itself.  

If you define this method, you must return a string and not echo anything. 

Example [ __toString Magic Method] 

 

<?php //__toString Magic Method example 
class magicMethod 
{ 
 function __toString() { 
  return "Joomla! CMS";} 
} 
$objMagic=new magicMethod; 
echo $objMagic; 

?> 
 

7. __clone() 

This magic method runs when you try cloning an instance of the class.  

To clone an instance, you use the keyword clone.  

By cloning an instance, you’re creating an object with the same properties and methods of the 
cloned object.  

They become 2 separate instances after that.  

This is useful when you want to save an instance at a certain state just in case. 

 

 

8. __isset 

__isset magic methods executes when function isset() is applied on property which is not 
available or not defined. It takes name of the parameter as an argument. 

9. __unset 

__unset magic method triggers when unset() method is applied on the property which is either 
not defined or not accessible. It takes name of the parameter as an argument. 

Example [ __isset & __unset Magic Method] 

<?php //__isset & __unset Magic Method 
class test 
{ 
function __isset($name){ 

echo "__isset is called for $name";} 
function __unset($name){ 
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echo "<br>__unset is called for $name";} 
} 
$a = new test(); 
isset($a->x); 
unset($a->c); 

?> 
 

10. __invoke() 

mixed __invoke ([ $... ] ) 

 This magic method runs when you try running an object as a method. 

<?php 

class test 

{ 

 function __construct() { 

  echo "Object Oriented Programming";} 

 function __invoke(){ 

   echo "<br>invoke magic method called";} 

} 

$obj=new test; echo $obj(); 

?> 

If you try to do the same thing on an object without an __invoke() method, you'll see this error: 

PHP Fatal error:  Function name must be a string in filename.php on line X. 

 

11. __sleep 

__sleep methods trigger when you are going to serialize your class object. 

public array __sleep ( void ) 

<?php 
class student 
{ 
 private $name; 
 function setName($name){ 
  $this->name=$name; } 
 function __sleep(){ 
  return array("name"); } 
} 
$obj=new student; $obj->setName("ABC"); $data=serialize($obj); echo $data; 

http://php.net/manual/en/language.pseudo-types.php#language.types.mixed
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?> 
12. __wakeup 

__wakeup executes when you are unserializing any class object. 

void __wakeup ( void ) 

<?php 
class student 
{ 
 private $name; 
 function setName($name){ 
  $this->name=$name;} 
 function __sleep(){ 
  return array("name"); } 
} 
$obj=new student; $obj->setName("ABC"); $data=serialize($obj); echo $data; 

var_dump(unserialize($data)); 
?> 
 

13. __autoload  as per autoloading class. 

 

Q.20 Explain Final Keyword.         Marks - 2 
PHP 5 introduces the final keyword, which prevents child classes from overriding a method by 
prefixing the definition with final.  

If the class itself is being defined final then it cannot be extended. 

 

 

Example #1 [Final methods example] 

<?php //final method example (cannot overridden) 
class Computer 
{ 
 final function test(){ 
  echo "Samsung";} 
} 
class LapTop extends Computer  
{ 
 function test() { 
  echo "Dell";} 
} 
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$objLaptop=new LapTop; $objLaptop->test(); 
?>  

Fatal error: Cannot override final method Computer::test()  

 

Example #2 [Final class example] 

<?php //final class example (cannot be extended (inherited)) 
final class Computer 
{ 
 function test() { 
  echo "Samsung";} 
} 
class LapTop extends Computer 
{ 
 function test() { 
  echo "Dell";} 
} 
$objLaptop=new LapTop; $objLaptop->test(); 

?> 
Fatal error: Class LapTop may not inherit from final class (Computer) 

Note: Properties (variables) cannot be declared final, only classes and methods may be declared as 
final. 

 

Q.21 Explain Object Cloning.         Marks - 3 
If you will directly copy objects in PHP, then it will copy by reference, not by value. Means if 
you will change main object data then copied object will be affected.  

Also if you will change value of the copied object then main object value will be changed.  

Syntax 

$y=$x; 
If you do this, $x and $y both print the same object.  

If any changes you make to the properties of object $y will automatically be made to object $x. 

Example #1 [Copying Object] 

<?php 
class Clone1 
{ 
public $a; 
private $b; 
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function __construct($x, $y){ 
$this->a = $x; 
$this->b = $y;} 

} 
$a= new Clone1("Java", "PHP"); 
$b= $a; //Copy of the object 
print_r($a); echo "<br>  "; 
$a->a = " Operating System "; 
print_r($a); echo"<br>  "; 
print_r($b);  

?> 
In the above example, $a is the object of Clone1 class and copy the reference of an object by 
using the assignment operator.  

You can see the changes of the program after assigning the value of $a to the $b. 

Example #2 [Copying Object] 

<?php  
class Clone1 
{ 
public $name; 
function __construct($z){ 

$this->name = $z;} 
function display(){ 

echo $this->name;} 
} 
$a= new Clone1("Audi"); 
echo "Before modification:<br>";  
$a->display(); $b=$a; 
$a->name="BMW"; 
echo"<br>after modification"; 
echo"<br>Using object a<br>"; $a->display();  
echo"<br>Using object b<br>"; $b->display();  

?> 
Clone Keyword 

If you want to make a copy of an object or you want to create objects by value in PHP, you 
need to clone it with the clone keyword like this. 

Cloning of an object is also known as shallow copy. 

 

Example #3 [clone keyword] 
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Syntax  $copy_of_object = clone $object; 

<?php 
class Clone1 
{ 
public$a; 
function __construct($z){ 

$this->a = $z;} 
} 
$obj= new Clone1("Java", "PHP");  
$obj1= $obj; //Copy of the object 
$obj2= clone $obj; 
print_r($obj); 
echo"<br>  "; 
$obj->a = " Operating System "; 
print_r($obj);echo"<br>  "; 
print_r($obj1);echo"<br>  "; 
print_r($obj2) 

?> 
In the above example, $obj is the object of Clone1 class, $obj is the copy of $obj and $obj2 is 
the clone of object $obj that means if you change the property of the class using this object 
does not affect the $obj2. 

Object cloning with magic method __clone 

Suppose you want to change value of your property a of the test class in case of cloning of 
object in PHP.  

We can change behavour of the clone object in PHP using magic method __clone.  

Magic method clone executes when object cloning is performed.  

As soon as PHP execute statement $c = clone $a, __clone method invoked.  

 

Example #4 [ __clone magic method] 

Syntax  : void__clone ( void ) 
<?php 

//__clone Magic Method example 
class test 
{ 
public $a; 
private $b; 
 function __construct($a, $b) { 
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  $this->a = $a; 
  $this->b = $b; }  
 function __clone() { 
  $this->a = "c"; } 
}  
 $a = new test("CCSIT" , "15035"); 
 $b = $a; //Copy of the object 
 $c = clone $a; //clone of the object 
 $a->a = "no Data"; 
print_r($a); echo '<br>'; print_r($b); echo '<br>'; 
print_r($c); echo '<br>'; print_r($a); 

?> 
So here $c->a will be “c”. Because __clone method will be invoked and only for object $c it will 
set value of $this->a to ‘c’. 

 

Q.22 Explain Comparing Objects.         Marks - 2 
When using the comparison operator (==), object variables are compared in a simple manner, 
namely: Two object instances are equal if they have the same attributes and values (values are 
compared with ==), and are instances of the same class.  

Example #1 [ Example of Object Comparison ] 

<?php 
class sum 
{ 
 var $a,$b; 
 function __construct($a,$b){ 
  $this->a=$a; 
  $this->b=$b;} 
} 
$obj1=new sum(10,20);$obj2=new sum(10,0); 
if($obj1==$obj2) 
 echo "<br>Both Objects are Equal"; 
else 
 echo "<br>Both Objects are not Equal"; 
?> 
 

Q.23 Explain Type Hinting.          Marks - 3
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PHP is not a strictly typed language means variable type declaration is not needed at all in PHP. 
Type declaration increases the readability of the code.  

Type Hinting in PHP is a mechanism to allow developers to specify the type of function arguments and 
return. You can add type for function and method parameters which can be used as a Type Hint. 

The definition of the Type Hinting specifies the parameter type when you call the function. If the argument 
type and the specified type does not match, PHP will generate a fatal error. 

In short, it allows you to control the execution how the type of data passed to the function. 

You can use type hinting to specify the expected data type of an argument in a function declaration.  

In PHP we can use type hinting for Object, Array and callable data type.  

You can also use interface in the type hinting. 

You can also override the method where you have used type hinting. 

Note: Type Hinting in PHP is not supported with int and string data types. 

Example #1 

<?php 
//Class where we are going to implement type hinting 
class Typehinting_Test 
{ 
//Implementation Type Hinting in PHP 
//Forcing to pass argument as object of class Test1 
public function type_hint_method(Test1 $parameter){ 
$parameter->test_method();} 
} 
     //Below is class 
class Test1 
{ 
public function __construct(){ 
//Do Nothing} 
//Method to call in the type hinting class 
public function test_method() { 
echo 'Type Hinting in PHP works';} 
} 
$th_test = new Typehinting_Test(); 
//$th_test->type_hint_method(1221) //Will give fatal error: Catchable fatal error: 
Argument 1 passed to Typehinting_Test::type_hint_method() must be an instance of 
Test1, integer given 
$t1 = new Test1(); 
$th_test->type_hint_method($t1); // Print Type Hinting in PHP works          ?> 

http://www.thecreativedev.com/tag/language/
http://www.thecreativedev.com/tag/error/
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Type Hinting also works with normal function outside of the class. You can force to pass only 
object of the class which implements the particular interface. Below is the example: 

 Example #2 [array in Typing Hint] 

classType_hint 
{ 
    functionhint_method(array$arr){ 
    print_r($arr);    }   
} 
classType_hint_new 
{ 
    function hint_object(Type_hint$obj){  // Here, If I didn’t pass in an Type_hintobject 
to hint_object(), a FATAL_ERROR was occurred. 
        //echo $obj->hint_method(); // Fatal Error: Argument must be an array 
        echo $obj->hint_method(array('P','H','P'));//First parameter must be an object 
of Type_hint class 
    } 
    function hint_null($obj=NULL){ 
            echo "Allow NULL"; } 
} 
$obj=newtype_hint(); 
$obj_new=newType_hint_new(); 
$obj->hint_method(array('C','C','S','I','T')); 
$obj_new->hint_object($obj);   
$obj_new->hint_null(NULL); 
 ?> 
 

Example #3 [using Class type in Type Hint] 

<?php 
class Test1 
{ 
public $var = 'this is test'; 
} 
function typehint(Test1 $t1){ 
echo $t1->var;} 
typehint(new Test1()); // Will print this is test 
?> 

Example #4 [Interface in Type Hint] 

<?php 
interface test 
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{ 
public function abc(); 
} 
//Implement the interface in the class 
class test1 implements test 
{ 
public function __construct() { 
;} 
public function abc() { 
echo 123;} 
} 
//do not implement interface 
class test2 
{ 
public function __construct() { 

;} 

public function abc() { 
echo 123;} 
} 
//Method where typehinting is by interface. 
function typehinttest(test $t){ 
$t->abc();} 
//Created object of the class 
$objTest1 = new Test1(); 
$objTest2 = new test2(); 
typehinttest($objTest1);//It will echo 123 
typehinttest($objTest2); // throw error    ?> 

Example #5 [Overriding Method in Type Hint] 

<?php 
class test1 
{ 
public function __construct() { 
//do nothing;} 
function abc(){ 
echo 'typehinging works'; 
} 
class parent_class 
{ 
function typeTest(test1 $objTest){ 
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$objTest->abc();} 
} 
class child_class extends parent_class 
{ 
function typeTest($at) { 
echo $at;} 
} 
$a = new child_class(); 
$a->typeTest('1233'); 
?> 
 

Q.24 Explain Late Static Bindings.         Marks - 3 
Late static binding in PHP can be used to reference the called class in context static inheritance.  

In PHP, we use the self keyword to access static properties and methods of classes.  

Self is resolved at compile time, which means that when class is inherited from another class, 
self will always relate to the class where it is mentioned not the class which is inheriting it.  

Example #1 [using self keyword] 

<?php 
 class Model{ 
 protected static $tableName = 'Model'; 
 public static function getTableName(){ 
  return self::$tableName;} 
} 
class User extends Model{ 
 protected static $tableName = 'User'; } 
echo User::getTableName(); // Model, not User How it works. 
?> 

First, we created a Model class that has $tableName static property with value Model and 
agetTableName() static method that returns the value of the $tableName.  Notice that we used 
the self and the operator :: to access static property inside the Model class. 

Second, we created another class named User that extends the Model class. The User class 
also has $tableName static attribute. 

Third, we called the getTableName() method of the User class. However, it returns Model 
instead of User. The reason is that self is always resolved to the class in which the method 
belongs. It means that if you define a method in a parent class and call it from a subclass, 
theself does not reference to the subclass as we expect. 

To overcome this issue, as of version 5.3, PHP introduced a new feature called PHP static late 
binding.  
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Basically, instead of using the self, you use the static keyword that references to the exact class 
that was called at runtime. 

 

Example #2 [using static keyword] 

<?php 
  
class Model{ 
 protected static $tableName = 'Model'; 
 public static function getTableName(){ 
  return static::$tableName;} 
} 
 class User extends Model{ 
 protected static $tableName = 'User';  
} 
echo User::getTableName(); // User Now we get the expected result. 
?> 

Notice that the static:: can only refer to static properties and static methods. 

 

Q.25 Explain Objects and References.        Marks - 3 
One of the key-points of PHP 5 OOP that is often mentioned is that "objects are passed by 
references by default". This is not completely true. This section rectifies that general thought 
using some examples.  

A PHP reference is an alias, which allows two different variables to write to the same value. As 
of PHP 5, an object variable doesn't contain the object itself as value anymore. It only contains 
an object identifier which allows object accessors to find the actual object. When an object is 
sent by argument, returned or assigned to another variable, the different variables are not 
aliases: they hold a copy of the identifier, which points to the same object.  

 

Example #1 References and Objects 

<?php 
class A { 
    public $foo = 1; 
}   
$a = new A; 
$b = $a;     // $a and $b are copies of the same identifier 
             // ($a) = ($b) = <id> 

http://www.zentut.com/php-tutorial/php-static/
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$b->foo = 2; 
echo $a->foo."\n"; 
$c = new A; 
$d = &$c;    // $c and $d are references 
             // ($c,$d) = <id> 
$d->foo = 2; 
echo $c->foo."\n"; 
$e = new A; 
function foo($obj) { 
    // ($obj) = ($e) = <id> 
    $obj->foo = 2; 
} 
foo($e); 
echo $e->foo."\n"; 
?> 
The above example will output: 
2 
2 
2 
 

Q.26 Explain Object Serialization.         Marks - 3 
serialize() returns a string containing a byte-stream representation of any value that can be 
stored in PHP. 

Using serialize to save an object will save all variables in an object. The methods in an object 
will not be saved, only the name of the class. 

That is, if you have an object of class A and serialize this, you'll get a string that refers to class A 
and contains all values of variables contained in it. 

 

 

<?php 
class sum 
{ 
 var $a,$b; 
 function __construct($a,$b){ 
  $this->a=$a; 
  $this->b=$b;} 
} 
$obj1=new sum(10,20); 

http://php.net/manual/en/function.serialize.php
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print_r($obj1); echo "<br>"; echo serialize($obj1); 
?> 
 

Object unserialization 
 unserialize — Creates a PHP value from a stored representationmixed  

unserialize ( string $str [, array $options ] ) 

unserialize() takes a single serialized variable and converts it back into a PHP value. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Unit – 2 Introduction   (PART – 1) 
 

Q.1 What is Content Management System (CMS)?       Marks - 3 

http://php.net/manual/en/language.pseudo-types.php#language.types.mixed
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The Content Management System (CMS) is a software which keeps track of the entire data (such as 
text, photos, music, documents, etc.) which will be available on your website. It helps in editing, 
publishing and modifying the content of the website.  

Top Ten Open Source CMS 
 WordPress 
 Joomla 
 Drupal 
 Media Wiki 
 Plone 
 Liferay 
 TYPO3 
 Moodle 
 Dolphin 
 Pligg 

Introduction of Joomla!: 

Basic Structure of Joomla 
 Front-end 

o Viewable by users 
 Back-end 

o Editable by administrator 
 Database 

o Stores information 

The What, When, Where, and Who of Joomla 
Here are four key things to know about Joomla: 
 

Q.2 What is Joomla?           Marks - 2 
Joomla is an open source Content Management System (CMS), which is used to build websites and 
online applications.  
It’s Web-publishing software. It’s designed for people to publish content online: news, blogs, 
photos, products, documents, events, or many other things. Because it allows you to manage your 
content, you often hear it called a Content Management System or CMS for short. 
It is free and extendable which is separated into front-end and back-end templates 

(administrator). Joomla is developed using PHP, Object Oriented Programming, software 
design patterns and MySQL (used for storing the data).  

Q.3 When did Joomla start?          Marks - 1 
Joomla has been around in various forms since 2000, which makes it one of the most established 
software projects on the Web.  
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Joomla is based on Mambo CMS which was developed by an Australian company in 2001 and 
initially released on August 17, 2005. The official version of Joomla 1.0 was released on September 
22, 2005. 

Q.4 Where did Joomla start?          Marks - 1 
It was created by Australians, which according to some people, explains many of the quirks.  
It now has developers based all over the world with particularly strong representation coming from 
Europe, North America, Southeast Asia, and of course Australia. 

Q.5 Who runs Joomla?          Marks - 1 
Rather than being run by a company, Joomla is operated by a nonprofit organization staffed by 
volunteers. 
Many of them have Joomla businesses in the daytime and volunteer in their spare time helping to 
keep the project running. 

Q.6 What Does the Joomla Name Mean?       Marks - 2 
Joomla isn’t a real word. It’s the phonetic spelling of a Swahili word “Jumla,” which means “all 
together” or “as a whole.” 
The logo is shown in Figure and was chosen during a competition in 2005. 
The winning designer started with several letter J’s for “Joomla” and rotated them until they fit 
together smoothly. 
Adding the circles to each J gave the impression of people, and the multiple colors gave the 
impression of different races, peoples, and cultures. 
The Joomla logo has the same meaning as the name: People all together as one. The What, When, 
Where, and Who of Joomla. 

Q.7  Explain Joomla! Core Features.        Marks - 5 
Joomla! is one of the world's most popular software packages used to build, organize, manage and 
publish content for websites, blogs, Intranets and mobile applications. Owing to its scalable MVC 
architecture its also a great base to build web applications. 
With more than 3 percent of the Web running on Joomla! and a CMS market share of more than 9 
percent, Joomla! powers the web presence of hundreds of thousands of small businesses, 
governments, non-profits and large organizations worldwide. 
As an award winning CMS led by an international community of more than a half million active 
contributors, helping the most inexperienced user to seasoned web developer make their digital 
visions a reality. 

Multilingual  
Joomla! is the most popular and 
widely supported open source 
multilingual CMS platform.   

Nested categorization 
Being able to create categories with 
nesting and no limits on depth is a great 
plus in helping manage large websites.  
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Well Supported 
There are thousands of professional 
Joomla! service providers 
throughout the world who can help 
build, maintain and market your 
Joomla! projects. 

 

Tagging 
When categorisation is not enough to 
structure your content, it's time to look at 
a flat organisation structure which is best 
served by tagging.   

Easy Updates 
One of the big challenges with any 
software is keeping it up to date. 
Fortunately, Joomla! has a "One 
Click Version Update" feature to 
make this process super easy for 
users of any skill level. 

 

Frontend Editing 
Editing content should be easy and fast. 
You are reading through your site's 
content and see a change you need to 
make. No need to login to the 
administrative section any more for 
simple edits of content and modules.  

 

Integrated Help System 
Joomla! has an in-app contextual 
help system to help every level of 
user to operate their Joomla. Most 
pages have a help button in the top 
right, helping you fully understand 
all options on that page.  

 

Content Versioning 
You will never again lose a previous 
important version of your article and 
other changes on your site. You are now 
able to track exactly who made what 
changes, when, and, if a version note was 
entered, why the item got edited.  

 

Media Manager 
The Media Manager is the tool for 
easily uploading, organizing and 
managing your media files and 
folders.   

Syndication and Newsfeed Management 
Make sure your visitors stay updated on 
the new content you're adding, even 
when they come only once in a while.  

 

Banner Management 
With the banner manager you have 
the possibility to easily add 
advertising and monetize your 
website. 

 

Menu Manager 
The Menu Manager allows you to create 
as many menus and menu items as you 
need.   

Contact Management 
The contacts component allows you 
to add several contacts, 
departments and categories, and 
extend the basic contact information 
with miscellaneous information and 
an image.  

 

Powerful Extensibility 
The Joomla! core is just the beginning, the 
real power is in the way you can 
customize Joomla. Over 7,500 extensions 
are available to extend your website and 
broaden its functionality.  
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Search better, Search Smarter 
With the built in search and smart 
search, your website visitors will be 
able to quickly and easily find the 
appropriate information on your 
site.  

 

Extensive ACL for all your access control 
needs 
ACL stands for Access Control List, it 
allows you to manage the users of your 
site, and different groups.   

Content Management 
Content creation is made very easy by the inbuilt WYSIWYG editor and allows you to edit 
content without any knowledge of code.   

 

Q. 8  Explain Advantages-Disadvantages of Joomla.      Marks - 3 
 It is an open source platform and available for free.  
 Joomla is designed to be easy to install and set up even if you're not an advanced user.  
 Since Joomla is so easy to use, as a web designer or developer, you can quickly build sites for your 

clients. With minimal instructions to the clients, clients can easily manage their sites on their own.  
 It is very easy to edit the content as it uses WYSIWYG editor (What You See Is What You Get is a 

user interface that allows the user to directly manipulate the layout of the document without 
having a layout command).  

 It ensures the safety of data content and doesn't allow anyone to edit the data.  
 By default, Joomla is compatible with all browsers. 
 The templates are very flexible to use.  
 Media files can be uploaded easily in the article editor tool.  
 Provides easy menu creation tool.  

Disadvantages  
 It gives compatibility problem while installing several modules, extensions and plugins 

simultaneously.  
 Plugins and modules are not free in Joomla.  
 Development is too difficult to handle when you want to change the layout.  
 Joomla is not much SEO (Search Engine Optimization) friendly.  
 It makes website heavy to load and run.  

 
Q.9 Real World Examples of What Joomla Can Create? [ Who uses Joomla!? ]  Marks - 3 

 Corporate web sites or portals  

 Corporate intranets and extranets  

 Online magazines, newspapers, and publications  

 E-commerce and online reservations  

 Government applications  

 Small business web sites  
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 Non-profit and organizational web sites  

 Community-based portals  

 School and religious web sites  

 Personal or family homepages 
 
Understand how Joomla! Works [Architecture] 
 
 
 
 
 
 
 

 Joomla is a Model-View-Controller web application. The following diagram shows the 
architecture of Joomla.  

 The architecture of Joomla contains following layers:  
  
 o Database  
 o Joomla Framework  
 o Components  
 o Modules  
 o Plugin  
 o Templates  
 o Web Browser  
  

 Database: Database is a collection of data and can be stored, manipulated and organized in a 
particular manner. The database stores the user information, content and many more required 
data of the site. It is used to store the administrative information to manage the Joomla site. Using 
Joomla database layer, it ensures maximum flexibility and compatibility for extension.  

 Joomla Framework: Framework is a collection of open source software, where the Joomla CMS is 
built. It is developed for more flexibility and breaks the framework into single modular packages 
which helps each package to develop more easily.  

 Components: Components are considered as mini applications. It consists of two parts i.e. 
Administrator and Site. Whenever a page gets loaded, component is been called to render the body 
of main page. The Administrator part manages different aspects of the component and the site part 
helps in rendering the pages when request is made by site visitor. Components are main functional 
unit of Joomla.  

 Modules: Modules is an extension which is used to render the pages in Joomla. It is also used to 
display the new data from the component. It frequently looks like boxes such as login module. In 

Database 

Joomla 

Framework 
Component

s 

Modules 

Plugin 

Templates Web 

Browser 
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Joomla administrator the modules are managed by the module manager. It displays the new 
content and images when module is linked to Joomla components.  

 Plugin: This is also a kind of Joomla extension, it is very flexible and powerful for extending the 
framework. It contains a bit of codes that is used to execute the particular event trigger. It is 
commonly used to format the output of a component or module when a page is built. The plugin 
function which are associated with event are executed in a sequence when a particular event 
occurs.  

 Templates: Template determines the look of the Joomla website. There are two types of 
templates used i.e. Front-end and Back-end. The Back-end template is used to control the functions 
by the administrator whereas the Front-end template is a way to present the website to users. 
Templates are easy to build or customize your site. It provides maximum flexibility to style your 
site.  

 Web Browser: It is a server where the user interacts. It delivers the web pages to the client. The 
HTTP (Hyper Text Transfer Protocol) is used to communicate between the client and the server. 
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Unit – 2  Installation & Configuration    [PART-2] 
 

Q.1 Explain Technical Requirements for Joomla! (System Requirements for Joomla!) Marks - 2 
Database: MySQL 5.1 +  
Web Server:  

o WAMP (Windows)  
o LAMP (Linux)  
o XAMP (Multi-platform)  
o MAMP (Macintosh)  
o Nginx  
o Microsoft IIS  

Operating System: Cross-platform  
Browser Support: IE (Internet Explorer 7), Firefox, Google chrome  
SSL (Secure Socket Layer): A valid security certificate is required for HTTPS  
PHP Compatibility: PHP 5.4+ or PHP 5.3.10+  

Recommended PHP.ini Settings 
There are some PHP settings that need to be sufficient for Joomla to install.  
The settings are usually in a "php.ini" or "user.ini".  
Talk to your host about how to change theses settings if it is possible to do so.  
If working on a localhost e.g. with XAMPP, you should not be restricted by these settings and VPS or 
dedicated hosting should also not be as restrictive. 

The values for PHP.ini below are suggested values only. 
memory_limit - Minimum: 64M Recommended: 128M or better 
upload_max_filesize - Minimum: 20M 
post_max_size - Minimum: 20M 
max_execution_time: At Least 120 Recommended: 300 

For building a Joomla site: 
Step 1: Installation 
Step 2: Content 
Step 3: Extensions (Components, Modules and Plugins) 
Step 4: Templates 
 

Q.2 Explain Installation of Joomla!        Marks - 5 
It was created by Australians, which according to some people, explains many of the quirks.  
Mainly follow the following steps to install Joomla! : 

o Create Database 
o Down zip file of Joomla from web site and extract in htdocs folder. 
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o Installed  

Main Configuration 
 With the above requirements met, a database created and the required Joomla! files in place, you 

are ready to install Joomla!.  
 Start the Joomla! web installer by opening your favorite browser and browsing to the site's domain 

name.  
 On host installation you will use http://www.yoursitename.com. If your are installing Joomla! 

locally, you will use http://localhost/<path to Joomla files>, and you should see the installation 
screen. 
Joomla! will try to identify the Select Language field automatically from your browser's language. 
You can change this if needed. 
Fill in the following information. 

 Site Name: the name of 
your website — this can 
be changed at any point 
later in the Site Global 
Configuration page. 

 Description: enter a 
description of the 
website. This is a global 
fallback meta description 
used on every page 
which will be used by 
search engines. 
Generally, a maximum of 
20 to 25 words is 
optimal. Again, this can 
be changed on the Site 
Global 
Configuration page at 
any time.  

 Admin Email Address: 
the admin email address. 
Enter a valid email in 
case you forget your 
password. This is the 
email address where you'll receive a link to change the admin password. 

https://docs.joomla.org/Special:MyLanguage/Help30:Site_Global_Configuration#Site
https://docs.joomla.org/Special:MyLanguage/Help30:Site_Global_Configuration#Site
https://docs.joomla.org/Special:MyLanguage/Help30:Site_Global_Configuration#Site
https://docs.joomla.org/Special:MyLanguage/Help30:Site_Global_Configuration#Site
https://docs.joomla.org/Special:MyLanguage/Help30:Site_Global_Configuration#Site
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 Admin Username: Joomla! uses a default "admin" as the username for the Super User. You can 
leave it as is, change it now (which a good Security measure) or use My Profile in the 
Administration interface to change it later. 

 Admin Password: remember that super user has maximum control of the site (frontend & 
backend), so try to use a difficult password. UseMy Profile in the Administration interface to change 
it later. Confirm the password in the Confirm Admin Password box. 

 Site Offline: click the Yes or No box. Yes - this means when installation is complete, your Joomla! 
website will display the 'Site is offline' message when you browse to yoursitename.com to view the 
home page. No - this means the site is live when you browse toyoursitename.com to view the 
home page. You can use the Site Global Configuration in the Administration interface to change the 
Offline status at any time. 

 When everything on the first page is completed, click the next button to proceed: 

Database Configuration 
You will need to enter the 
information about the 
database you will use for 
Joomla! now. It was 
suggested to write this 
information down under 
"Prepare for Install" tab. 
You may also read or 
review Creating a Database 
for Joomla!. 
For simplification, these 
instructions are a 
reference to installing with 
a MySQLi database. The 
instructions on the 
installation page are self-
explanatory, but here they 
are again: 

 Database Type: MySQLi is 
the common database 
used 

 Hostname: Where is your 
database located? Common is localhost, but some hosts use a specific database server such 
as dbserver1. yourhost.com 

 Username: the username used to connect to the database 
 Password: the password for the database's username 

https://docs.joomla.org/Special:MyLanguage/Security_Checklist/Joomla!_Setup#Change_the_default_administrator_username
https://docs.joomla.org/Special:MyLanguage/Help30:Site_My_Profile
https://docs.joomla.org/Special:MyLanguage/Help30:Site_My_Profile
https://docs.joomla.org/Special:MyLanguage/Help30:Site_Global_Configuration#Site
https://docs.joomla.org/Special:MyLanguage/Creating_a_Database_for_Joomla!
https://docs.joomla.org/Special:MyLanguage/Creating_a_Database_for_Joomla!
http://en.wikipedia.org/wiki/MySQLi
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 Database Name: the name of the database 
 Table Prefix: one is generated automatically, but you can change it. For example, jos3_ can be used. 

Just don't forget to put the underscore character (_) at the end of the prefix. 
 Old Database Process: should the installer backup or delete existing tables during the installation of 

new tables? Click, Yes or No to select the choice. 
All these choices can be edited on the Site Global Configuration page, under Server options after 
the installation is completed. Note, you will break your installation if you change these settings 
after installation unless you have a complete copy of the current database being used by the 
Joomla! Installation. Common uses would be to update the username and password of the 
database or to complete a move of an existing installation to a new host with different parameters. 
When all the information has been filled in, click the next button to proceed: 

Finalisation 

Overview 
It is now time to finalise the Joomla! installation. The last page of the web browser installation 
contains all the information about the installation. This includes the options(at the top) for 
installing sample data and the installation's configurations(at the bottom). 

Install Sample Data and Email Configurations 
The first options are for automatically installing sample content to the website and emailing the 
configuration settings. 
If you are new to Joomla! it would be beneficial to install some sample data to see how Joomla! 
works. You can at this time choose to have the configuration settings emailed to you. If the Email 
Configuration choice is selected, the Email Password choice will appear. The email password is off 
by default for security. You can choose to have the password included, just click Yes. 
Time to check the configurations of your install and the environment of the installation. 
 

Configuration Check 

Checking Your Configurations 
If everything is in order, you will see the install at the top of the overview page. If not, this is the 
place to check and see what may be causing an issue. 
The section is broken into 4 groups: 

 Main Configuration: all the website specific information, such as the website name, description, 
admin username, etc. 

 Database Configuration: contains the information about the database Joomla! will use. 
 Pre-Installation Check: these requirements must all be shown as Yes, otherwise you will not be able 

to install Joomla! With the exception of the PHP Version, the rest are usually controlled in 
the php.ini. You may need assistance from your host in correcting these settings or checking to see 
if it is possible to adjust them. 

https://docs.joomla.org/Special:MyLanguage/Help30:Site_Global_Configuration#Server
http://en.wikipedia.org/wiki/INI_file
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 Typical PHP settings that might cause the install to fail and may need adjusting include the 
following with suggested values: (1) memory_limit (64M), (2)max_execution_time (300), (3) 
post_max_size (30M), (4) upload_max_filesize (30M). For more information, see PHP configuration 
file file. 

 Recommended Settings: these are settings are recommended in your PHP configuration, but will 
not prevent Joomla! from being installed. You can refer to the above instructions on how they may 
be changed. 
If everything is correct and all checks are passed, you may now click the Install button in the top 
right corner of the Overview page. This will start the actual installation process. 
After you click the Install button, you should see a progress bar with additional information of the 
installation. Once the installation completes, you should see the success page! 

Finishing Up 

Success and Finishing Up the Installation 
Congratulations! Joomla! 3 is now installed. If you want to start using Joomla! right way 
without installing extra languages there is one last step to complete the installation. You must 
delete the Installation Folder. Click on Remove Installation folder and a success message will 
appear. Now you can navigate to the Administrator log in by clicking Administrator or go right to 
your site by clicking Site. 

Finalise 

 
You will now be presented with a very similar Congratulations! Joomla! is now installed. screen. 
The difference will be a notation of the default Administrator and Site language settings, if they 
were set. You will also not see the Extra Steps message in the bottom right. 
Now you can delete the Installation Folder. Click on Remove Installation folder and a success 
message will appear. Now you can navigate to the Administrator log in by clicking Administrator or 
go right to your site by clicking Site. 
 

http://php.net/manual/en/configuration.file.php
http://php.net/manual/en/configuration.file.php
https://docs.joomla.org/Special:MyLanguage/J3.x:Installing_Joomla#Installing_Extra_Languages
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Q.3  Explain Admin Panel in joomla.        Marks - 5 
 After installing Joomla you are able to login to your Joomla Admin Panel as described below:  

Step 1:  
 To access Joomla administrative panel, open the browser and type the 

URL as http://localhost/< Your_joomla_folder 
>/administrator/index.php, then you will get the screen as shown below: 

Step 2:  
 Enter the username and password which you had mentioned during 

installation as shown in the step 3 of Set Up Wizard section and click on the 
login button. 
 
Dashboard Overview: (Joomla Control Panel) 
 
 The Control Panel provides default features and functions of Joomla to access through clickable 

icons, menu bar etc.  
 When you login to the Joomla administrative panel, you will get the screen as shown below.  

 Important icons of control panel and their functions are marked in the following screen – 
 

Article Content 
There are four icons under the CONTENT section as shown below − 

 New Article − It creates a new article page. 
 Articles − It manages all your present articles. 
 Categories − It creates new categories and helps in publishing/unpublishing the categories. 
 Media − It manages the files by uploading various new files or deleting the existing ones on your 

web server. 

Structure Format 
In STRUCTURE section, there are two groups of icons − 

 Menu − Menu manager allows creating custom menus for your website and navigating through 
your website. 

 Module − It manages the modules such as location and function of modules that are installed on 
site. 
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User Information 
Under USERS section, there is one icon located − 

 Users − It manages the user information, which allows creating or deleting the user, changing 
passwords, time and languages. You can also assign the user to User Groups. 

 
 

Set the configuration 
Three icons are located under the CONFIGURATION section as given below − 

 Global − This is an important part in the Joomla back-end. Any changes made in this configuration, 
will affect the entire website. 

 Template − It manages the templates used in the website. 
 Language(s)  − It manages installed language by setting the default language for your site. 

Install Extension 
There are many Extensions available in Joomla. You can install different types of extensions to 
extend the functionality of the site. 

Maintenance 
In MAINTENANCE section, there are two icons located − 

 Joomla is up-to-date − It views the current update status of the Joomla installation. 
 All extensions are up-to-date − It views the current update status of the Joomla extension. 

Logged-In User 
It shows the administrator name who has logged in to the Joomla site. 

Published Articles 
It shows the published articles and also shows the present article, that you have published. 

Information of Sites 
It displays the details of the site such as OS name, version of PHP and MySQL etc. and also shows 
the number of users that are using this site. 

Joomla Toolbar 
In this chapter we will study about the various toolbar options in Joomla. Given below is a list of 
toolbars − 

 Article Manager Toolbar 
 Category Manager Toolbar 
 Media Manager Toolbar 
 Menu Manager Toolbar 
 Module Manager Toolbar 
 User Manager Toolbar 
 Global Configuration Toolbar 
 Template Manager Toolbar 
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Article Manager Toolbar 
Click on Content → Article Manager in Joomla administrator control panel.  
In Article Manager, you can create the standard pages that consist of images, text and hyperlinks.  
The following figure depicts the Article Manager Toolbar. 

 
 New − Create a new article. 
 Edit − Edit any specific article. 
 Publish − Publish the article to the user on the website. 
 Unpublish − Unpublish the article to the user on the website. 
 Featured − Selected article is featured. Multiple articles can also be featured. 
 Archive − It can change the status of the articles to published or unpublished by selecting archived 

in the select status filter. 
 CheckIn − Check-in the selected article. Multiple articles can be checked-in. 
 Trash − Delete the selected article permanently. 
 Batch − Selected articles are processed by batch. 
 Help − Help button is used to open the help screen. 
 Option − It opens the setting window where you can change the setting of the articles. 

Category Manager Toolbar 
 Click on Content → Category Manager in Joomla administrator control panel.  
 It manages to create categorize the articles which allows to group your content better.  
 The following figure depicts the Category Manager Toolbar. 

 
 New − Add a new category. 
 Edit − Edits an existing category. 
 Publish − Publish the categories to the user on the website. 
 Unpublish − Unpublish the categories to the user on the website. 
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 Archive − It can change the status of the categories to published or unpublished by selecting 
archived in the select status filter. 

 CheckIn − Check-in the particular selected category. Multiple categories can be checked-in. 
 Trash − Delete the selected category permanently. 
 Batch − Selected categories are processed by batch. 
 Rebuild − It is used to rebuild the categories tree data. 
 Help − Help button is used to open the help screen. 
 Option − It opens the setting window where you can change the setting of the articles. 

Media Manager Toolbar 
Click on Content → Media Manager in Joomla administrator control panel. It manages the files by 
uploading a new file or deleting the existing ones on your web server. Given below is a snapshot of 
the Media Manager Toolbar. 

 
 Upload − Upload images from your system. 
 Create New Folder − Create a new folder on Joomla server. 
 Delete − Deletes the selected item/images permanently. 
 Help − This opens the help screen. 
 Option &minus- It opens the setting window where you can change the setting of the articles. 
  

Menu Manager Toolbar 
Click on Menus → Menu Manager in Joomla administrator control panel. It manages the menu 
items. Here new menus are created, deleted or menus are managed subsequently. Given below is a 
snapshot of the Menu Manager Toolbar. 

 
 New − It creates a new menu item. 
 Edit − Edits the selected menu item. 
 Delete − Deletes the selected menu item permanently. 
 Rebuild − It rebuilds or refreshes the relevant menu items present. 
 Help − Help button is used to open the help screen. 
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 Option − It opens the setting window where you can change the setting of the articles. 

Module Manager Toolbar 
Click on Extension → Module Manager in Joomla administrator control panel. It manages the 
modules location and functions that are installed. The following figure depicts the Module Manager 
Toolbar. 

 
 New − It creates new modules. 
 Edit − It edits the selected modules. 
 Duplicate − A copy of the selected module can be created using this button. 
 Publish − Publish the selected modules to the user on the website. 
 Unpublish − Unpublish the selected modules to the user on the website. 
 CheckIn − Check-in the particular selected modules. Multiple modules can be checked-in. 
 Trash − Delete the selected modules permanently. 
 Batch − Selected modules are processed by batch. 
 Help − Help button is used to open the help screen. 
 Option − It opens the setting window where you can change the setting of the articles. 

User Manager Toolbar 
Click on Users → User Manager in Joomla administrator control panel. It manages all the user 
information such as Username, Email, Last Visit Date and Registration Date. Given below is the 
snapshot of the User Manager Toolbar. 

 
 New − It creates a new user. 
 Edit − It edits the selected user. 
 Activate − It activates multiple users. 
 Block − It blocks the selected user. 
 Unblock − It unblocks the selected users. 
 Delete − It deletes the particular users. 
 Batch − Selected users are processed as a batch. 
 Help − Help button is used to open the help screen. 
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 Option − It opens the setting window where you can change the setting of the articles. 

Global Configuration Toolbar 
Click on System → Global Configuration in Joomla administrator control panel. It manages the 
global setting of the Joomla site. Given below is a snapshot of the Global Configuration Toolbar. 

 
 Save − Saves the configuration and stays on the same screen. 
 Save & Close − Saves the configuration and closes the screen. 
 Cancel − Cancels the configuration changes and returns to the previous screen without saving. 
 Help − Help button is used to open the help screen. 

Template Manager Toolbar 
Click on Extension → Template Manager in Joomla administrator control panel. It manages the 
templates that you use in the website. The following picture shows the Template Manager Toolbar  

 
 Default − Sets the particular selected style as default. 
 Edit − Edits the template pages. 
 Duplicate − Creates a duplicate template. 
 Delete − Deletes the template. 
 Help − Help button is used to open the help screen. 
 Option − It opens the setting window where you can change the setting of the articles. 

Language Manager Toolbar 
Click on Extension → Language Manager in Joomla administrator control panel. It manages the 
languages that you use in the website. The following picture shows the Language Manager Toolbar  
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 Default − Sets the particular selected language as default. 
 InstallLanguage − Install the required language. 
 Help − Help button is used to open the help screen. 
 Option − It opens the setting window where you can change the setting of the articles. 

 
 
Q.4 Explain How to add, edit, delete, publish & batch process category.   Marks - 5 
 

Category: Category is used to create categories for the articles which allow grouping your content better.  

Add new Category : 
 Click on Content --> Categories --> Add New Category on the Joomla administrative panel, then you 

will get the following screen image:  
 

 To Click on New. 

 
 Here, we have mentioned the details about the column header present on the Category Manager 

page. 

 
 Checkbox: It is used to select one or more category items by clicking on the box.  
 Status: Specifies the status of the category i.e. Publish/Unpublish.  
 Title: Specifies the name of the title in the category.  
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 Access: Specifies the access level, i.e. Public or Private.  
 Language: Specifies the item language used.  
 ID: It is the unique identification number assigned to the items automatically.  

 
 

Edit Category: 
1. Click System --> Control Panel 

 
2. Then select Categories from the Content Option placed on right side of the control panel. 

 
3. Click on Categories displayed the following screen : 
4. Here, all the available categories are displayed. Select any one you want to edit and then click on 

Edit button. 

 
5. After editing the category click Save & Close button. 

Delete Category: 
1. Click System --> Control Panel 
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2. Then select Categories from the Content Option placed on right side of the control panel. 

 
3. Click on Categories displayed the following screen : 
4. Here, all the available categories are displayed. Select any one you want to delete and then click on 

Trash button. 

 
5. After deleting the category message displayed on screen. 

 

Publish Category: 
1. Click System --> Control Panel 

 
2. Then select Categories from the Content Option placed on right side of the control panel. 
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3. Click on Categories displayed the following screen : 
4. Here, all the available categories are displayed. Select any one you want to publish and then click 

on Trash button. 

 
5. After publish the category message displayed on screen. 

 

 

 

Batch Process Category: 
1. Click System --> Control Panel 

 
2. Then select Categories from the Content Option placed on right side of the control panel. 
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3. Click on Categories displayed the following screen : 
4. Here, all the available categories are displayed. Select any one you want to publish and then click 

on Batch  button. 

 
5. To Select options and click on Process Button. 

 

 

Article 

Adding Contents [using Article] 
how to add content on the Joomla website. 
To adding content in your website using Article. 
What is Article :  
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An Article is some written information that you want to display on your site. It normally contains 
some text and can contain pictures and other types of content. 

Adding Content 
Following are the simple steps to add content in Joomla. 

Step (1) − Click on Content → Article Manager → Add New Article as shown below. 

 

Step (2) − After clicking on Add New Article, you will get the editor page of the Article Manager as 
shown below. 
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Following are the details of the fields on editor page of the Article Manager. 

Title 

 
 Title − It is used to write the title of the article. This title gets displayed on the page. 
 Alias − It is auto generated from the given title name. 

TinyMCE editor 
It is a WYSIWYG Editor, which is similar to a word processor interface where we can edit the 
contents of the article. 

 
First Row − They appear on the top of the Editor page and contain a group of related commands. 

 Edit − Undo, Redo and Cut, Copy, Paste, Select all. 
 Insert − Insert image, Insert link, Horizontal line, Special Character. 
 View − Visual Aids. 
 Format − Bold, italic, underline and various formats are available in this group. 
 Table − It is used to display the table format in the article by using row and columns. 
 Tools − It displays the source code of your article in html format and the code will be displayed in a 

new popup window. 
Second Row − In this row, we can see that there are 4 buttons present − 

 The first button is used to make font bold, italic, underlined and strikethrough. 
 The second button is used to do the alignment of the content i.e. Left, center, right and full. 
 The third button is used to select pre-defined format for the text i.e. Paragraph, heading, text or 

pre. 
 The fourth button is used to display the list format either by using bullet or numbers. 

Third Row − 
 The first button is used for indentation of paragraphs or text, either indent to the left side or right 

side. 
 The second button is used to undo or redo the content. 
 The third button is used to insert or remove the link, insert images and display the source code of 

your article in html format. 
 The fourth button is used to add a horizontal line and add tables by using a dropdown option. 
 The fifth button is used to superscript and subscript the text. 
 The sixth button is used to insert the special character in the text. 

Details 
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Category − It is used to select the category for your article. 
Tags − It is used to display the tags on the front-end page. 
Status − You can select any of the following status for your article − 

 Published − Items get published on the website. 
 Unpublished − Items do not get published on the website. 
 Archived − Items will not get displayed in the menu list as well as on blogs. 
 Trashed − Items will be deleted from the site. 

Featured − It is used, whether to display the article on the home page or not by using the buttons 
YES/NO. 
Access − You can select an access level for your item from the list box. 
Language − It selects the language for its item. 
Version Note − It is used to note the version of the item. It is optional. 

Text Insertion 
It is used for writing the content of an article. 

Editor Buttons 
Five buttons present at the bottom of the text editor as shown below are the editor buttons. 

 
 ArticleButton − Click on Article button a window pops-up as shown below. Here, we can select the 

required article to view. 

 
 Image − Click on the Image button, a window pops-up as shown below. Here, you can add the 

details of the images. After filling all the fields, click on Insert Button. 



  SHREE H. N. SHUKLA COLLEGE OF I.T. & MGMT. 
(AFFILIATED TO SAURASHTRA UNIVERSITY) 
 

   2 – Vaishalinagar    3 – Vaishalinagar  
   Nr. Amrapali Railway Crossing  Nr. Amrapali Railway Crossing 
   Raiya Road     Raiya Road 
   Rajkot – 360001    Rajkot - 360001 
   Ph.No–(0281)2440478,2472590   Ph.No–(0281)2471645 
 

 

 

82 

 

 
 Directory − Search the particular directory present in image folder. 
 Image URL − Insert image URL. 
 Image Description − Write brief description about particular image. 
 Image Title − Write the name of the image. 
 Image Float − Set the image location. 
 Caption − Write a caption for the image. 
 Caption Class − It calls Joomla libraries to load the image. 

 PageBreak − Click on Page Break button, a window pop-up will get displayed as shown below. 

 
 PageTitle − Enter the title of the page. 

 TableofContentsAlias − Enter the table content alias. 
 ReadMore − Click on the ReadMore button, The red dotted line gets displayed in the editor. The 

further information part of the article gets displayed after the read dotted lines or sometimes it 
displays the entire article. 

 Toggleeditor − TinyMCE editor will get displayed or its get invisible. 

Toolbar 
Following are the toolbar options − 

 Save − Saves the contents and stays on the same screen. 
 Save & Close − Saves the content and closes the screen. 
 Save & New − Saves the content and opens a new content page. 
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 Cancel − Cancels the content changes made into it and returns to the previous screen without 
saving. 
To format content on the Joomla website. 

Formatting(Edit) Content 
Following are the simple steps to format content in Joomla − 
Step (1) − Click on ArticleManager in Control Panel as shown below. 

 

 
Step (2) − Select the article to be formatted by clicking on the checkbox. Next, click on 
the Edit button as shown below. 

 
Step (3) − Next, the article opens up for editing as shown below. Here editing content or formatting 
as required. 
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Toolbar 
Following are the toolbar options − 

 Save − Saves the contents and stays on the same screen. 
 Save & Close − Saves the content and closes the screen. 
 Save & New − Saves the content and opens a new content page. 
 Save as Copy − Saves the formatted content and copies it. 
 Versions − It is used to select versions of the page. 
 Close − Closes the article without formatting. 

 
Q.5 Explain User Manager, Groups and Access Levels.      Marks - 5 
 

 One of the most powerful aspects of a CMS like Joomla is the User Management features.   
 Joomla has greatly extended the web developers ability to control exactly what users can see and 

what they can do when the get to the website. 
 With your website you may have many contributors that add content to the site,  
 you may have areas that you only want paid subscribers to see,  
 you may have several people in the company adding content to the site, and you may want 

a few individuals to be able to access everything on the site and have control over all of the 
settings. 

 Joomla has default User Groups and Access Levels for the users on the site, but you can modify the 
default groups and levels and add as many as you wish. 
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How to access 
You can access the User Manager by clicking on the User Icon on the left in the Control Panel. 
Alternatively, use top menu bar, Users → Manage. 

 

 

Column Headers 
In the table containing the users from your Joomla! Site, you will see different columns. Here you 
can read what they mean and what is displayed in that column. 

 Checkbox: Check this box to select one or more items. To select all items, check the box in the 
column heading. After one or more boxes are checked, click a toolbar button to take an action on 
the selected item or items. Many toolbar actions, such as Publish and Unpublish, can work with 
multiple items. Others, such as Edit, only work on one item at a time. If multiple items are checked 
and you press Edit, the first item will be opened for editing. 

 Add a Note: Create a Note for the user. 
 Display x note(s): Show the Note(s) for the user. 
 Name: The full name of the user. 
 Username: The name the user will log in as. 
 Enabled: Whether or not the user is enabled. 
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 Activated: Whether or not the user is activated. Normally when a user registers from the front end, 
some type of activation is required. This is controlled by the New User Account Activation 
parameter in the Users Configuration → Component screen.  

 User Groups: The list of groups that the user belongs to. Note that a user may belong to more than 
one group. 

 Email: The email address from the user is displayed here. 
 Last visit: Here you can see the date on which the user last logged in. 
 Registration Date: The date the user was registered. 
 ID: This is a unique identification number for this item assigned automatically by Joomla!. It is used 

to identify the item internally, and you cannot change this number. When creating a new item, this 
field displays 0 until you save the new entry, at which point a new ID is assigned to it. 

Toolbar 
At the top left you will see the toolbar: 

 

The functions are: 
 New: Opens the editing screen to create a new user. 
 Edit: Opens the editing screen for the selected user. If more than one user is selected (where 

applicable), only the first user will be opened. The editing screen can also be opened by clicking on 
the Name of the user. 

 Activate: Activates multiple users. Select all the users required using their check-boxes then click 
this button. 

 Block: Blocks one or more users. Select the users to be blocked using their check-boxes then click 
this button. 

 Unblock: Unblocks one or more users. Select the users to be unblocked using their check-boxes 
then click this button. 

 Delete: Deletes the selected users. Works with one or multiple users selected. 
 Batch: Batch processes the selected users. Works with one or multiple items selected. 
 Options: Opens the Options window where settings such as default parameters can be edited. 
 Help: Opens this help screen. 

 

List Filters 
Filter by Partial User Name 

Search Users. In the upper left is a Search field and two buttons, as shown below. 

 

https://docs.joomla.org/File:Help30-New-Edit-Activate-Block-Unblock-Delete-Options-Help-toolbar-en.png
https://docs.joomla.org/File:Help30-Users-User-Manager-search-filter-subscreen-en.png
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Enter part of the user's name and press the Search to find matching names. Press x or Clear to clear 
the search field and restore the list of users. 
Filter by User State, Active State, Group, Last Visit Date or Registration Date 

Search Tools are five drop-down list boxes as shown below. 

 
 State: Select the desired state (Enabled or Disabled) to limit the list based on state. Select "- State -" 

to list Enabled and Disabled users. 
 Active State: Select "Activated" to list only users that have been activated. Select "Unactuated" to 

select only users who have not yet been activated. Select "- Active State -" to select both type of 
users. 

 Group: Select a group from the list box to list only users who are members of that group. Select "- 
Group -" to select users regardless of group. 

 Last Vist Date: Select time frame from a list to show only users who visited in a selected time 
frame. Select "- Last Vist Date -" to select users regardless of last visited date. 

 Registration Date: Select time frame from a list to show only users who registered in a selected 
time frame. Select "- Registration Date -" to select users regardless of registration date. 

Batch Process 
The Batch Process allows a change in settings for a group of selected users. To use: click on the 
Batch button found on top of the table of users being viewed to activate the drop down field area. 
How to Batch Process a group of users: 

 Select one or more users on the list by selecting the desired checkbox(es). 
 Set one or more of the following values: 

 To change the User Group, select the desired new User Group from the User Group list box. 
 Choose Add To Group, Delete From Group or Set To Group to do the desired action. 
 Decide if a Password Reset is wanted. 

 When all of the settings are entered, click on Process to perform the changes. A message "Batch 
process completed successfully." will show. 

Front-end Access Levels 

Guest 
As you would expect, this is for users who aren't signed into the site. You can't grant this access 
level to anybody, but you can grant it to items on your site so they are visible only to guests. It's 
perfect for a "Log in" menu item that you don't need to show to logged in users. 

Registered 

https://docs.joomla.org/File:Help30-Users-User-Manager-other-filter-subscreen-en.png
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This is the default login group. Registered users usually have access to hidden areas of your site like 
members content, downloads or the like. 

Author 
Authors have the ability to create and submit new content but they can't actually publish it. 
Authors can also edit their own articles once approved and published by a Publisher or 
Administrator. Use this level for members if you would like them to be able to submit new content 
to your site. 

Editor 
Editors are very similar to Authors but they can edit anybody's articles not just there own. They still 
can't publish or delete items though. We don't see this one used very much. Use this level for 
people you want to spell check or format items submitted by Authors before being approved by a 
Publisher. 

Publisher 
This is the highest front-end only access level. Publishers can create and edit any content and they 
are the only group with permission to  publish or unpublish content. The only limitation on 
Publishers is they can't delete content. 

Back-end Access 

Manager 
Managers have very similar roles to Publishers with the ability to create and edit categories and 
menu items through the backend interface.  
All other admin functions like installing extensions, managing modules and most other components 
isn't even visible to them. Use this for users that have the responsibility to manage content. 
Interestingly, if you have a look at the permissions in the User Manager configuration screen, 
Managers have permission to create, edit and delete users but they are denied access to the User 
Managers admin interface rendering those permissions useless. 
 

Administrator 
This is the level I prefer to create for clients when handing sites over. 
The key difference with administrators is they have the ability to manage other users. 
Administrators can create new user accounts, reset passwords and block access. In addition to 
managing users, Administrators can manage content and menus and configure extensions. 
The only limitations on Administrators is they cannot install or change site templates, global 
configuration options or access Super Administrator's user profiles. 

Super Administrator 
This is the Big Daddy of them all. They have access to install, configure, update and delete anything 
they like. 
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Super Administrators have the power to break a site very easily. I've had to help a few people who 
have turned off authentication or user plugins effectively locking everyone out of the site - even 
themselves. So, use this access group carefully. Super Admin access should only be granted to one 
or two key people who know what they are doing. 

How to Create Joomla User Groups and Access Levels 
User groups and Access levels makes it possible to organize and define permissions for users in 
Joomla. 
The default user groups in new sites are Registered, Manager, Super User, etc. These groups 
enough for regular projects, however sometimes it's required to create custom groups. 
In this tutorial, I'm going show you how to create a user group and to assign it to an access level. 
 

Step #1. Create a user group 
Groups are useful to categorize your site users and define roles. When a new account is created, it 
will belong to at least one of the available groups such as "registered", "super user", "editor", etc. 
To create a new user group go to: 

1. Users 
2. Groups 
3. Add new group 

 
Type a Group title. 
Choose a Parent; for example "registered". 

 
Save and close 
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Step #2. Create an access level 
Viewing access level will set the permissions for: 
What users from a group (or groups) can see. 
What users from a group (or groups) can do. 
To create a new access level go to: 

1. Users 
2. Access levels 
3. Add new access level 

 
 Type a Level title. 
 Check the user group you 

created in step 1. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 Save and close 

Note: you can assign more than one user group into a single access level. 

Step #3. Test the access 
 Create a menu item, article, category, or other type of 

content that support ACL. 
 In "Access" field, choose the new level. 

Access levels control which users can view which objects 
on your site. Objects include menu items, modules, 
categories, and component items (articles, contacts, and so 

https://www.ostraining.com/blog/joomla/access-level-several-usergroups/
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on). Each object in the site is assigned to one access level. User groups are also assigned to each 
access level. 
If a user is a member of a group that in turn has permission for an access level, then that user can 
view all objects assigned to that access level. It is important to understand that user groups can be 
arranged in a parent-child hierarchy. If so, then a child group has access to all access levels that the 
parent group has access to. So you don't need to assign a child group access to levels that its parent 
group already has access to. 

Global Configurations:  
To access this screen you can either: 

 Click the Global button in the ControlPanel, or 
 Select System → Global Configuration from the drop-down menus. 

 

Details 

Site 
 Site Name: Enter the name of your Web site. This will be used in various locations (e.g. the backend 

browser title bar and Site Offline pages). 
 SiteOffline: (Yes/No). Select whether access to the Site frontend is available. If Yes, the frontend 

will display or not a message depending on the settings below. 
 OfflineMessage: (Hide/Use Custom Message/Use Site Language Default Message). Display or not a 

frontend message when the site is offline. The custom offline message uses the value defined in the 
'Custom message' field. The language offline message uses the value defined in the site language ini 
file. 

 CustomMessage: The custom offline message will be used if the 'Offline Message' field is set to 
'Use Custom Message'. 

 OfflineImage: Select or upload an optional image to be displayed on the default offline page. Make 
sure the image is less than 400px wide. 

 Mouse-over Edit Icons for: (Modules & Menus/Modules/None). Select if you want mouse-over edit 
icons for modules and menu items (support may depend on your template) 

 Default Editor: (Editor - CodeMirror/Editor - None/Editor - TinyMCE). Select the default text editor 
for your site. Registered Users will be able to change their preference in their personal details if you 
allow that option. 

 Default Captcha: (None Selected). Select the default captcha for your site. You may need to enter 
required information for your captcha plugin in the Plugin Manager. 

 Default Access Level: (Guest/Public/Registered/Special/Customer Access Level (Example)/Super 
Users). Select the default access level for new content, menu items, and other items created on 
your site. 

 Default List Limit: (5/10/15/20/25/30/50/...). Sets the default length of lists in the Control Panel for 
all users 

https://docs.joomla.org/Special:MyLanguage/Help30:Site_Control_Panel
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 Default Feed Limit: (5/10/15/20/25/30/50/...). Select the number of content items to show in the 
feed(s). 

 Feed Email Address: (Author Email/Site Email/No Email). The RSS and Atom newsfeeds include the 
author's email address. Select Author Email to use each author's email (from the User Manager) in 
the news feed. Select Site Email to include the site 'Mail from' email address for each article. 

 Site Meta Description: Enter a description of the overall website that is to be used by search 
engines. Generally, a maximum of 20 words is optimal. 

 Site Meta Keywords: Enter the keywords and phrases that best describe your website. Separate 
keywords and phrases with a comma. 

 Robots: (Index, Follow/No index, follow/Index, No follow/No index, no follow). Robots instructions. 
 Content Rights: Describe what rights others have to use this content. 
 Show Author Meta Tag: (Yes/No). Show the author meta tag when viewing articles. 
 Show Joomla! Version: (Yes/No). Show the Joomla! version number in the generator meta tag. 
 Search Engine Friendly URLs: (Yes/No). Select whether or not the URLs are optimised for Search 

Engines. 
 Use URL Rewriting: (Yes/No). Select to use a server's rewrite engine to catch URLs that meet 

specific conditions and rewrite them as directed. Available for IIS 7 and Apache. Apache users 
only! Rename htaccess.txt to .htaccess before activating.IIS 7 users only! Rename web.config.txt to 
web.config and install IIS URL Rewrite Module before activating. 

 Adds Suffix to URL: (Yes/No). If yes, the system will add a suffix to the URL based on the document 
type. 

 Unicode Aliases: (Yes/No). Choose between transliteration and unicode aliases. Transliteration is 
default. 

 Include Site Name in Page Titles: (After/Before/No). Begin or end all Page Titles with the site name 
(for example, My Site Name - My Article Name). 

 Cookie Domain: Domain to use when setting session cookies. Precede domain with '.' if cookie 
should be valid for all subdomains. 

 Cookie Path: Path the cookie should be valid for. 

System 
 Path to Log Folder: For logging of Joomla. Please specify a folder. 
 Help Server: (English (GB) - Joomla help wiki/Français (FR) - Aide de Joomla!). Select the name of 

the help server from which your system will collect the help screen displays. 
 Debug System: (Yes/No). If enabled, diagnostic information, language translation, and SQL errors (if 

present) will be displayed. The information will be displayed at the foot of every page you view 
within the Joomla Backend and Frontend. It is not advisable to leave the debug mode activated 
when running a live website. 

 Debug Language: (Yes/No). Select whether the debugging indicators (**...**) or (??...??) for the 
Joomla! Language files will be displayed. Debug Language will work without Debug System being 
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activated, but you will not get the additional detailed references that will help you correct any 
errors. 

 Cache Handler: (Cache_Lite/File). Choose cache handler to enable caching. Native caching 
mechanism is file-based. Please make sure the cache folders are writable. 

 Path to Cache Folder: Specify a writable folder to store cache files if you do not wish to use the 
default folder. 

 Cache Time: The maximum length of time in minutes for a cache file to be stored before it is 
refreshed. 

 Platform Specific Caching: (Yes/No). Enable or disable platform specific caching. Enable when HTML 
output on mobile differs from other devices. (Default disabled.) 

 System Cache: (OFF - Caching disabled/ON - Conservative caching/ON - Progressive caching). 
Enable or disable caching and set caching level. Conservative level: smaller system cache, 
Progressive level: faster, bigger system cache, includes module renderers cache. Not appropriate 
for extremely large sites. 

 Session Handler: (Database/PHP). The mechanism by which Joomla! identifies a User once they are 
connected to the website using non-persistent cookies. If PHP is selected, the session.save-
handler value from the PHP configuration will be used 

 Session Lifetime: Auto log out a User after they have been inactive for the entered number of 
minutes. Do not set too high. 

 Shared Sessions: (Yes/No). When enabled, a user's session is shared between the frontend and 
administrator sections of the site. Note that changing this value will invalidate all existing sessions 
on the site. 

 

Server 
 Path to Temp Folder: Please select a writable Temp folder. 
 Gzip Page Compression: (Yes/No). Compress buffered output if supported. 
 Error Reporting: This parameter sets the level of error reporting to be used by PHP on the Joomla 

site. It has five options: System Default, None, Simple, Maximum and Development. “System 
Default” leaves the level of PHP error reporting to that set up in the server (usually in 
the php.ini file). “None” switches off PHP error reporting, and “Simple”, “Maximum” and 
“Development” override the server setting to give a basic level of reporting (for “Simple”) and the 
reporting of all errors (“Maximum” and “Development”). 
Tip: Should your Joomla site fail to the extent that it is not possible to use the administrator page to 
activate error reporting, you can switch on full PHP error reporting by editing 
the configuration.php file. Changing the $error_reporting parameter in that file to a value of 
'maximum' is the equivalent to setting Error Reporting to “Maximum”. 

 Force HTTPS: (None/Administrator Only/Entire Site). Force site access in the selected areas to occur 
only with HTTPS (encrypted HTTP connections with the httpsː// protocol prefix). Note, you must 
have HTTPS enabled on your server to utilise this option. 
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 Server Time Zone: (Universal Time, Coordinated (UTC)/Abidjan/Accra/Addis 
Ababa/Algiers/Asmara/...). Choose a city in the list to configure the date and time for display. 

 Enable FTP: (Yes/No). Enable the built in FTP (File Transfer Protocol) functionality which is needed 
in some server environments to be used instead of the normal upload functionality of Joomla! 

 Enable Proxy: (Yes/No). Enable Joomla to use a proxy which is needed in some server environments 
in order to fetch URLs like in the Joomla Update component 

 Database Type: (MySQL (PDO)/MySQLi). The type of database in use entered during the installation 
process. Do not edit this field unless you are having to migrate to a different type of database, 
perhaps due to changing your hosting provider. 

 Host: The hostname for your database entered during the installation process. Do not edit this field 
unless absolutely necessary (e.g. the transfer of the database to a new hosting provider). 

 Database Username: The username for access to your database entered during the installation 
process. Do not edit this field unless absolutely necessary (e.g. the transfer of the database to a 
new hosting provider). 

 Database Name: The name for your database entered during the installation process. Do not edit 
this field unless absolutely necessary (e.g. the transfer of the database to a new hosting provider). 

 Database Tables Prefix: The prefix used for your database tables entered during the installation 
process. Do not edit field unless absolutely necessary (e.g. the transfer of the database to a new 
hosting provider). 

 Send Mail: (Yes/No). Select Yes to turn on mail sending, select No to turn off mail sending. Warning: 
It is advised to put the site offline when disabling the mail function! 

 Disable Mass Mail: (Yes/No). Select Yes to disable the Mass Mail Users function, select No to make 
it active. 

 From email: The email address that will be used to send site email. 
 From Name: Text displayed in the header "From:" field when sending a site email. Usually the site 

name. 
 Reply To email: The email address that will be used to receive end users(s) reply. 
 Reply To Name: Text displayed in the header "To:" field when end users(s) reply to received email. 
 Mailer: (PHP Mail/Sendmail/SMTP). Select which mailer for the delivery of site email. 

 
 

Permissions 

Manage the permission settings for the user groups below. See notes at the bottom. 
 Site Login: (Not Set/Allowed/Denied). Allow or deny Site Login for users in the Public group. Allows 

users in the group to login to the frontend site. 
 Administrator Login: (Not Set/Allowed/Denied). Allow or deny Administrator Login for users in the 

Public group. Allows users in the group to login to the Backend Administrator site. 
 Offline Access: (Not Set/Allowed/Denied). Allow or deny Offline Access for users in the Public 

group. Allows users in the group to access to the Frontend site when site is offline. 
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 Super User: (Not Set/Allowed/Denied). Allow or deny Super User for users in the Public group. 
Allows users in the group to perform any action over the whole site regardless of any other 
permission settings. 

 Access Administration Interface: (Not Set/Allowed/Denied). Allow or deny Access Administration 
Interface for users in the Public group. Allows users in the group to access all of the administration 
interface except Global Configuration. 

 Create: (Not Set/Allowed/Denied). Allow or deny Create for users in the Public group. Allows users 
in the group to create any content in any extension. 

 Delete: (Not Set/Allowed/Denied). Allow or deny Delete for users in the Public group. Allows users 
in the group to delete any content in any extension. 

 Edit: (Not Set/Allowed/Denied). Allow or deny Edit for users in the Public group. Allows users in the 
group to edit any content in any extension. 

 Edit State: (Not Set/Allowed/Denied). Allow or deny Edit State for users in the Public group. Allows 
users in the group to edit the state of any content in any extension. 

 Edit Own: (Not Set/Allowed/Denied). Allow or deny Edit Own for users in the Public group. Allows 
users in the group to edit any content they own in any extension. 

 Edit Custom Field Value: (Not Set/Allowed/Denied). Allows users in the group to edit any value of 
custom fields submitted in any extension. 

Text Filters 

 

 These text filter settings will be applied to all text editor fields submitted by users in the selected 
groups. These filtering options give more control over the HTML your content providers submit. 
You can be as strict or as liberal as you require to suit your site needs. The filtering is opt-in and the 
default settings provide good protection against markup commonly associated with Web site 
attacks. 

Toolbar 
At the top left you will see the toolbar: 

 

The functions are: 
 Save: Saves the global configuration settings and stays in the current screen. 
 Save & Close: Saves the global configuration settings and closes the current screen. 
 Cancel: Closes the current screen and returns to the previous screen without saving any 

modifications you may have made. 
 Help: Opens this help screen. 

 

https://docs.joomla.org/File:Help30-Save-SaveClose-Cancel-Help-toolbar-en.png
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Q.6 Explain Joomla Update:  (Live Update, Upload & Update).     Marks - 5 

 
This screen allows Joomla! to be updated quickly by downloading the current update package from 
the Joomla! code repository if there is an update. This setting is the default setting. 

How to Access 
 Select Components → Joomla! Update from the drop-down menu of the Joomla! Administrator 

Panel. 
 The following options are displayed :  

 

Joomla 3.7.5, Update now! 
The recommended way to update installations of Joomla! is to use the Joomla Updater component 
found in the Components menu of your site Administrator. 

Live Update Tag :  
The update screen when an update is available. 

 

To Click on Install the Update button display the following screen: 
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Upload & Update Tag :  

 

Updates are available! 2 
 Displayed the available updates list. Select and click on Update button. 
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Q.7 Explain Banners, Contacts, News Feed & Smart Search.     Marks - 5 

Banner  (Component Menu) :  

What is Banners? : Banner is used for advertising on webpage. 
The Banners component has two main tasks: 

 Shows advertising banners 
 Collects all the data about those banners, such as the number of times each one has been shown 

and the number of times each one has been clicked on. 
A banner uses the CASh workflow of Categorize, Add, Show.  

Categorize Banner 
1. Click Components --> Banners --> Categories.  

 
2. Click New.  

 

 
3. Give the title -> CCSIT Banner 

 
4. Click on Save & Close button after finished. 

Adding Banner 
Step (1): Click Components --> Banners --> Banners in Joomla administrator, you will get the 
following screen. 

 
Step (2): Next, click on New button, you will get the following screen. 
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 There are different tabs present in above screen.  
 By default, Details tab is active.  
 This tab displays the details of the banner. 

 

 
Below we have mentioned the details of the fields present on the Details tab.  

 Name: This block is used to write the name of the item.  
 Alias: This is auto generated from the given name.  
 Type: Displays the banner type i.e. image or Custom (HTML code).  
 Image: Displays the image file of the banner.  
 Width: Set the width of the banner image.  
 Height: Set the height of the banner image.  
 Alternative Text: It represents the alternative text to display on banner image.  
 Click URL: When user clicks on the banner then it will navigate to the specified URL.  
 Description: Brief description about the banner.  

Following fields are present on the right side of the Details tab.  
 Status: It displays the status of the banner such as Published, Unpublished, Archived and Trashed.  
 Category: It displays the category of the banner.  
 Pinned: It displays whether the banner is Pinned or not. For that we have to select either (Yes/No) 

button.  
 Language: It displays the specified language of the banner.  
 Version Note: It displays the version of the items on the banner.  

Step (4): After clicking on Banner Details tab, you will get the following screen. 
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Step (5): Click on Publishing tab, you will get the following screen.  

 
 

Following fields are present on Banner Details tab.  

 Max. Impressions: Display the maximum number of 
impressions purchased for the banner. Unlimited 
checkbox indicates unlimited number of impressions 
to be allowed for the banner.  

 Total Impressions: Shows the total number of 
banners displayed to a user on a web page. You can 
reset the Total Impressions to zero.  

 Total Clicks: Displays the total number of times 
banners were clicked. You can reset the Total Clicks 
to zero.  

 Client: Shows the client for the specified banner.  

 Purchase Type: It shows the banner purchase type 
such as Use Client Default, Unlimited, Yearly, 
Monthly, Weekly and Daily.  

 Track Impressions: It specifies the number of tracks 
the banner is displayed on web page.  

 Track Clicks: It specifies the number of track clicks 
on the web page.  
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 Start Publishing: It indicates the date on which the banner is to be published on the web page.  
 Finish Publishing: It indicates the date on which the banner is to be stopped from being published 

on the web page.  
 Created Date: It indicates the date on which the banner was created.  
 Created by: It indicates the name of the user who has created the banner.  
 Created by alias: It indicates the name of the alias who has created the things required in banner.  
 Modified Date: It indicates the last modified date of the banner.  
 Modified by: It indicates the name of the user who has last modified the banner.  
 Revision: It indicates the number of revisions for the banner.  
 ID: It indicates the number of identity needed for the banner.  

Following fields are present on right side of the Publishing tab.  
 Meta Keywords: It specifies the different meta keywords and it should be represented either by 

lowercase or uppercase.  
 Use Own Prefix: It specifies to use your own prefixes by selecting either (Yes/No).  
 Meta Keyword Prefix: It specifies the prefixes of meta keywords and it takes those prefixes which 

are available in meta keywords tag.  

Show 
Now we just need to tell Joomla where to show the banner: 
1. Go to Extensions --> Module Manager --> New. 
2. You see a pop-up screen where you can decide which type of module to create. Click Banners. 
3. You see a screen like Figure. There are four key options to choose: 

 Title: Give the module a logical name such as Left Column Banner. 
 Show Title: Hide. 
 Position: Select Position-8, which is where all of our other modules are located. 
 Category: Choose the category you created earlier. 

Click Save & Close, and you’re finished. Click View Site, and you can see your banner. 
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Toolbar  
Following are the toolbar options present in Adding Banners.  

 Save: Saves your Banner.  
 Save & Close: Saves the Banner and closes the current screen.  
 Save & New: Saves the Banner and opens a New create banner screen.  
 Cancel: Cancels the created banner in Joomla!.  

Contacts : (Component Menu) 
 The Contacts component has one main task: It allows visitors to contact you. 
 You probably guessed that already. 
 Contacts allows you to easily set up Contact Us forms. If you just want one 
 contact form for the whole site, that’s easily done.You can also set up a whole 
 directory of contact forms for different people or different departments. 

The CASh workflow applies to contacts just as much as for content, menus, and banners. We’re 
going to Categorize, Add, and then Show. 
 

Categorize 
Just as with our articles and banners, our contacts are organized into categories: 

1. Click Components --> Contacts --> Categories. 

 
2. Click New. 
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3. Click Save & Close. 

 

 

Add 
To create the contact form, follow these steps: 
1. Click Components --> Contacts --> Contacts. 

 
2. Click New, and you see the contact form creation page. To fill in at least three fields as you create 

your first contact form: 

 

 
 Name: Give the contact form a descriptive title. For example, as we’re making a general contact 

form for the city, enter Joomlaville Mayor. 
 Category: Choose the Joomlaville Contacts category you created earlier. 
 Email: Click the Contact Details tab on the right-hand side of the page and enter your e-mail 

address into the Email field.This e-mail won’t be made public, but whenever anyone uses the 
contact form, an e-mail gets sent to this address. 

3. When all three fields are filled in, your screen should look like Figure Click Save & Close to complete 
this contact form. 

Show 
Now that we have our contact form ready, the final step is to make it publicly visible via a menu 
link: 

1. In the Administrator area, go to Menus and then Main Menu. 
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2. Click New, and you see the menu link setup page. I recommend you set these three fields: 

 

 
 

 Menu Item Type: Choose Single Contact. 
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 Menu Title: Contact Us. 
 Select Contact: Choose CCSIT College-Junagadh.  
 Then click Save & Close. and then View Site. You should be able to see your new menu link in the 

Main Menu.  
 When you click on it you see your new contact form 

News Feed : (Component Menu) 
The News Feeds component allows you to automatically show news from other Web sites. 
News Feeds use a technology called RSS or Real Simple Syndication to pull in the feeds from other 
sites. 

Categories: 
1. Click Components --> Newsfeeds -->  Categories. 
2. Click New.  
3. Enter a general title for our category such as News from Other Sites. 
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Add 

First, we need to find the feeds that we’re going to import. The normal way to do this is to browse 
to the sites you’re interested in and look for a little RSS icon. The common design for an RSS icon is 
a square image with a dot in the bottom-left corner and two waves coming out of it toward the top-
right corner. If you’re not sure what RSS feed icons look like, I’ve posted some examples at  
http://joomlaexplained.com/chapter7. 
When looking for RSS feeds on other sites, you may need to 
hunt around a little as different sites put the feed in different 
places. Some put their RSS icons in the browser bar, some in the 
sidebar, and some in the site footer. 

1. Go to Components, Newsfeeds, and then Feeds. 
2. Click New and you see the News feeds creation page. I 

recommend you fill in at least three fields as you create your first contact form: 

 

 Name: Give the contact form a descriptive title. In this example we’re going to list the latest Joomla 
extensions, so a logical title might be Latest Joomla Extensions. Sometimes this Joomla stuff is hard, 
isn’t it? 

 Link: Enter http://feeds.joomla.org/JoomlaExtensions. 
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 Category: Choose the News from Other Sites category you created earlier. 

Show 
All we need now is to make a menu link to our news feed: 

1. In the Administrator area, go to Menus and then Main Menu. 
2. Click New and you see the menu link setup page. I recommend fill in three fields: 

o Menu Item Type: Choose Single News Feed. 
o Menu Title: Enter Latest Joomla Extensions. 
o Feed: Latest Joomla Extensions. 

3. Click Save & Close and then View Site.You should see your new menu link in the Main Menu. When 
you click on it you see your feed as in 

Search (Components Search) 
Search Manager allows you to see how many searches were done for each key combination and 
what was the result for each search.  
Click Components --> Search, a screen as shown below will get displayed. 

 

Smart Search (ComponentsSmart Search) 
It enhances site search.  
Click Components --> Smart Search, a screen as shown below will get displayed.  
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Below, we have mentioned the details about the column header present in the Smart Search page.  
 Checkbox: It is used to select one or more items by clicking on the box.  
 Status: Specifies the status of the items i.e. Publish/Unpublish.  
 Title: Specifies the name of the title.  
 Type: Specifies the type of the page i.e. Article or Tag.  
 Last Updated: Specifies the date of the last modification. 

 

 

Unit – 2 Templates (Part-3) 

 

Q.1 What is a template?          Marks - 3 
 A template is basically the design of your Joomla! powered website. 
 A template is a type of Joomla! extension that changes the way your site looks.  
 Templates have certain fields in which the component (just one) and modules (as many as you like) 

will be shown. Templates are easy to build or customize and they provide maximum flexibility in 
how you style your site. 

 It provides the framework that brings together common elements, modules and components as 
well as providing the cascading style sheet for your site.  

 There are two types of templates used by the Joomla! CMS: 
o Front-end Templates (Site) 

https://docs.joomla.org/Extension
https://docs.joomla.org/Template
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o Back-end Templates. (Administrator)  
 The Front-end Template controls the way your website is presented to the user viewing the 

website's content.  
 The Back-end Template controls the way your website's administrative tasks are presented for 

controlling management functions by a Joomla! Administrator.  
o Management feature: Admin head menu > “Extensions” > “Template ” 

 
 

Q.2 Explain Template Directory Structure.       Marks - 5 
 Joomla! CMS templates use a structure of directories and files but they can vary from template to 

template 
 Site templates (templates that change what your website looks like) can be found in 

the/templates directory.  
 For example, if your template is called "mytemplate", then it would be placed in the folder: 

o <path-to-Joomla!>/templates/mytemplate 
 Administrator templates (templates that change what the administrator section of the site looks 

like) can be found in the /administrator/templates directory.  
 For example, if your administrator template is called "myadmintemplate", then it would be placed 

in the folder: 
o <path-to-Joomla!>/administrator/templates/myadmintemplate 

Template directories  
 A typical template for Joomla! will include the following directories: 

o css - contains all the .css files 
o html - contains template override files for core output and module chrome 
o images - contains all images used by the template 
o language - contains additional language files used by the template 

 Depending on the complexity and design of the template is may also contain: 
o JavaScript - contains supporting JavaScript used by the template for added functionality 

Example structure with files 
 Typical path of a template is  

o <root>/public_html/domain-name/template/<name of your template>  
Which will contain the following directories and files based on your template. 

Directories 

o /css  

o /html  

o /images  

o /javascript  

https://docs.joomla.org/Template
https://docs.joomla.org/Template
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o /language 

Files 

o component.php  

o error.php  

o favicon.ico  

o index.php  

o templateDetails.xml  

o template_preview.png  

o template_thumbnail.png  

 

Template files 

It is most common for a template to have at least the following files: 
 index.php: Provides the logic for the display and positioning of modules and components. 
 component.php: Provides the logic for the display of the printer friendly page, "E-mail this link to a 

friend." etc. 
 error.php: Provides a method to handle errors such as 404, page not found error. 
 favicon.ico : favicon icon file 
 template.css: Handles the presentational aspects of the template including specifications for 

margins, fonts, headings, image borders, list formatting, etc. The .css files may also be located in 
the /css directory. 

 templateDetails.xml: Holds meta-information related to the template and is used by the Installer 
and the Template Manager. 

 template_preview.ext - replace .ext with the extension format of the image (.jpg, .png, .gif) 
Generally a 600x400 pixel image that is shown when the cursor is clicked on the thumbnail image in 
Template Manager:Templates, not Template Manager:Styles. This gives the Administrator a pop up 
modal window of the template before applying it to the Site. 

 template_thumbnail.ext - replace .ext with the extension format of the image (.jpg, .png, .gif) 
Generally a 200x150 pixel thumbnail image that is shown when viewing the Template list in 
Template Manager:Templates, not Template Manager:Styles . This gives the Administrator a 
thumbnail view of the template before applying it to the Site. 

 The templateDetails.xml file is required for Joomla! templates and it can be found in the root 
template directory of any template inside the Joomla! templates directory.  

 This XML file holds the basic meta-data that Joomla! needs in order to display and provide it as 
template option in the backend.  

 It also contains a variety of other meta-data that is used to provide information about the template 
and the template authors and define files and folders that are used by the template.  
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 It also defines template language files, as well as parameters and settings the template will offer in 
the backend. 

 The templateDetails.xml file uses a fairly basic XML format and structure. The XML data in this file is 
separated into sections and specifically formatted in to render the various pieces and parameters. 
The XML data is read and parsed by powerful tools in the Joomla! core, then rendered to register 
the template and create the display seen in the Template Manager. This provides template 
developers a relatively simple method for creating assignments, settings and parameters for use in 
the template. 

 The implementation of templateDetails.xml will vary from template to template, it can be simple or 
complex depending on what features the template offers. The default Joomla! 3 Protostar template 
serves as an excellent example to demonstrate how this file is used.  

XML Format 
 The top two lines of every templateDetails.xml file need to start with defining the XML format and 

doctype. 
<?xml version="1.0" encoding="utf-8"?>  
<!DOCTYPE install PUBLIC "-//Joomla! 2.5//DTD template 1.0//EN" 
"http://www.joomla.org/xml/dtd/2.5/template-install.dtd"> 

 The next line is also required as it tells Joomla! that the data in this file is to be used for an 
extension, in this case a template.  

 All template data is contained within this <extension> tag, and the file concludes by closing this 
tag </extension>. 

o <extension version="3.1" type="template" client="site"> 

Basic Details 
 The first section is generally where template developers include information about the template.  
 Information such as names, dates, contact information, copyrights, version number and a basic 

description are common.  
 This data is used in the Template Manager and is shown in the list of available templates and can be 

displayed in the template editing screens as well. 
 

Template Basic Details as seen in  

Template Manager > Templates 
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Template Details example 
 Protostar XML code for basic details: 

<extension version="3.1" type="template" client="site">  
<name>protostar</name> <version>1.0</version>  
<creationDate>4/30/2012</creationDate>  
<author>Kyle Ledbetter</author>  
<authorEmail>admin@joomla.org</authorEmail>  
<copyright>Copyright (C) 2005 - 2014 Open Source Matters, Inc. All rights reserved.</copyright>  
<description>TPL_PROTOSTAR_XML_DESCRIPTION</description> 

 You may notice that the final line of this code, the description, contains a language string and not 
the actual description.  

 This string references a language file in the template where the actual description is defined and 
written.  

 This is a preferred method in Joomla! for extensions that are distributed for public use to 
accommodate international language support, however one could simply type the description if 
translation is not a concern.  

 The language files are also defined in the templateDetails.xml file, in the language section 

Template Description seen in Protostar Editor 

 

Folder Structure 
 

 All Folders related to the template installation are listed here. All files and folders located in the 
root of the template directory during installation need to be listed here.  

 Any files contained inside a folder that is listed are automatically included.  
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 Each folder contains full path information starting at the template root.  
 The Administrator's Installer uses this information when storing the files during installation. 
 Below is the file and folder structure from the default Protostar template.  
 This is a fairly standard file structure for a basic Joomla! template. 

<files>  
<filename>component.php</filename>  <filename>error.php</filename> 
<filename>favicon.ico</filename>  <filename>index.php</filename> 
<filename>templateDetails.xml</filename> <filename>template_preview.png</filename> 
<filename>template_thumbnail.png</filename> <folder>css</folder> 
<folder>html</folder> <folder>images</folder> <folder>img</folder> <folder>js</folder> 
<folder>language</folder> <folder>less</folder>  
</files> 

 

File directory view of Protostar Template  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Module Position 
 The available Module Positions that can be used in the template are defined in this area. 
 These are the module positions defined in the default Protostar template: 

https://docs.joomla.org/Special:MyLanguage/Module_Position
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<positions>  
<position>breadcrumb</position>  
<position>header</position>  
<position>position-0</position>  
<position>position-1</position>  
<position>position-2</position>  
<position>position-3</position>  
<position>position-4</position>  
<position>position-5</position>  
<position>position-6</position>  
<position>position-7</position>  
<position>position-8</position>  
<position>position-9</position>  
<position>position-10</position>  
<position>position-11</position> 
<position>position-12</position>  
<position>position-13</position>  
<position>position-14</position>  
<position>footer</position>  
</positions> 

 

 The list of positions are contained within the <positions> tag. Each <position> tag creates a module 
position that is available from the position list in the module manager and in other areas of Joomla! 
where module positions can be selected. 

 The simple format of the position list means it can be easily customized.  
 For example, to add a new module position to the list, simply add a new<position> tag inside 

the <positions> tag with a unique name using all lowercase letters with no spaces.  
 Keep in mind, this only adds the position to the backend and additional development in other 

template files is required to render the new position on the front end. 

Languages 
 Some templates may include language files to allow translation of static text in the template.  
 Notice that the language folder is defined and the two language files inside are also included.  
 Even though the language folder was defined earlier, these files need their own definitions.  
 This method tells Joomla! where the language files that contain strings used by the template reside. 

o The first file holds the language file for text that will be viewed by the User.  
o The second file, with the .sys, or system, extension is for text that will be viewed in the 

Administrator area. 
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 This is the language folder and file structure from the default Protostar template: 
  

<languages folder="language">  
<language tag="en-GB">en-GB/en-GB.tpl_protostar.ini </language> 

<language tag="en-GB">en-GB/en-GB.tpl_protostar.sys.ini </language>  
</languages> 

  
 Language strings are used in templates and throughout Joomla! for the purpose of utilizing the 

extensive international language support features in Joomla!.  
 This method provides developers and users with a relatively simple method to translate any text 

that is used in templates and extension screens.  
 Joomla! will check the language files for any language strings that are used and load the 

corresponding text in the language chosen by the user in place of the string.  
 In this instance, there are only files for English (en-GB), any text translations in other languages 

must be provided by Users or Developers before they can be used by Joomla!. 

Parameters 
 A template may offer display options and other parameters that can be chosen by the 

Administrator in the Template Manager.  
 For instance, the default Protostar template allows the Administrator to change various colors, 

fonts and add a logo, these parameters are found under the advanced tab, which is also defined 
and created by the XML parameters. 

 Template parameters are contained inside a <config> tag, which contains a <fields> tag with a name 
attribute of "params".  

 Inside the <fields> tag is where the parameter groups and individual parameters are defined.  
 The<fieldset> tag is used to create groups of parameters. Individual parameters are defined with 

the <field> tag. 
 Each <fieldset>, and each <field> parameter within a <fieldset>, require a unique name defined by 

the name attribute.  
 This name defines the parameter itself and is used to pass settings to the front end files.  
 Each parameter should also contain a label attribute and description attribute.  
 The label text appears with the parameter in the settings screen to identify what the setting is used 

for and more detailed information can be included in the description. 
 A parameter field can be virtually any type of form input with corresponding options, this is 

selected by the type attribute. 
 Any necessary options, such as radio button or select choices, are defined in <option> tags.  
 CSS class names can be defined with the class attribute. and a default parameter setting can be 

defined using the default attribute. 
 Below are the parameter definitions in the default Protostar Template.  
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 In this example, all Labels, Descriptions and Options are using language string definitions from the 
Language files defined in the previous section, as well as some from the Joomla! core, so they can 
be translated into different languages as necessary. 

 

<config>  

<fields name="params">  

<fieldset name="advanced">  

<field name="templateColor" class="" type="color" default="#08C" 

label="TPL_PROTOSTAR_COLOR_LABEL" description="TPL_PROTOSTAR_COLOR_DESC" />  

<field name="templateBackgroundColor" class="" type="color" default="#F4F6F7" 

label="TPL_PROTOSTAR_BACKGROUND_COLOR_LABEL" 

description="TPL_PROTOSTAR_BACKGROUND_COLOR_DESC" />  

<field name="logoFile" class="" type="media" default="" 

label="TPL_PROTOSTAR_LOGO_LABEL" description="TPL_PROTOSTAR_LOGO_DESC" />  

<field name="sitetitle" type="text" default="" label="JGLOBAL_TITLE" 

description="JFIELD_ALT_PAGE_TITLE_LABEL" filter="string" /> 

<field name="sitedescription" type="text" default="" label="JGLOBAL_DESCRIPTION" 

description="JGLOBAL_SUBHEADING_DESC" filter="string" />  

<field name="googleFont" type="radio" class="btn-group btn-group-yesno" default="1" 

label="TPL_PROTOSTAR_FONT_LABEL" description="TPL_PROTOSTAR_FONT_DESC" >  

<option value="1">JYES</option>  

<option value="0">JNO</option>  

</field> 

<field name="googleFontName" class="" type="text" default="Open+Sans" 

label="TPL_PROTOSTAR_FONT_NAME_LABEL" 

description="TPL_PROTOSTAR_FONT_NAME_DESC" />  

<field name="fluidContainer" type="radio" class="btn-group btn-group-yesno" default="0" 

label="TPL_PROTOSTAR_FLUID_LABEL" description="TPL_PROTOSTAR_FLUID_DESC" >  
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<option value="1">TPL_PROTOSTAR_FLUID</option>  

<option value="0">TPL_PROTOSTAR_STATIC</option>  

</field>  

</fieldset>  

</fields>  

</config> 

 

 The Protostar template illustrates a few different ways that XML can be used in a template 
interface, but there are many more possibilities. In this example, the <fieldset 
name="advanced"> tag encloses all of the parameters and it uses the name attribute to create the 
"Advanced" tab in the interface.  

 All that is necessary to create another tab in the interface is another <fieldset> tag with a 
different name attribute.  

 With this in mind, it is relatively simple to create as many additional tabs and parameters as 
necessary in a template. 

 The index.php file is the skeleton of the website.  
 Every page that Joomla! delivers is "index.php" fleshed out with a selection of content inserted 

from the database. 
 The index.php file for a template contains a mixture of code that will be delivered as it is, and php 

code, which will be modified before it is delivered.  
 The code will be familiar to anyone who has designed a simple html webpage: there are 2 main 

sections - the <head> and <body>.  
 Where index.php differs is the use of php code to insert information selected from a database. 
 Here is an example: 
 A tradition HTML head section: 

<head>  
<title>My Example Webpage</title>  
<meta name="title" content="example" />  
<link rel="stylesheet" href="www.example.com/css/css.css" type="text/css" />  
</head> 

 And the same thing done the Joomla! way: 
<head>  
<jdoc:include type="head" />  
<link rel="stylesheet" href="<?php echo $this->baseurl ?>templates/mytemplate/css/css.css" 
type="text/css" />  
</head>  
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Unit – 3 Component (Part-1) 

 
Q1. What is a Joomla Component ?         Mark - 2 

A Joomla component is a core element of Joomla.  

Components are displayed in a Joomla-powered website’s main body position as defined by the template’s 
developer.  

Joomla is preloaded with a few core components (banners, contacts, news feeds, etc.) . But 3rd party 
Joomla components are widely developed and implemented by Joomla community members.  

Joomla allows you to create more complex content and add specific functionality on top of the standard 
articles that consist of text, images and links. You can do that via the Components manager.  

If you want to create a page with news feed for example, you need to go to Components -> Newsfeeds -> 
Feeds and than click the big green NEW button. 

 

Q2. Explain MVC (Model, View, Controller)       Mark - 3 

The Model-View-Controller (MVC) is an architectural pattern that separates an application into three main 
logical components: the model, the view, and the controller.  

Each of these components are built to handle specific development aspects of an application.  

MVC is one of the most frequently used industry standard web development framework to create scalable 
and extensible projects. 

MVC Components Following are the components of MVC − 

 

Model  

The Model component corresponds to all the data-related logic that the user works with. This can 
represent either the data that is being transferred between the View and Controller components or any 
other business logic-related data.  

 

View  

The View component is used for all the UI logic of the application. For example, the Customer view will 
include all the UI components such as text boxes, dropdowns, etc. that the final user interacts with.  

 

Controller  
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Controllers act as an interface between Model and View components to process all the business logic and 
incoming requests, manipulate data using the Model component and interact with the Views to render the 
final output. 

 

Q3. Explain Joomla Component Framework.       Mark-1 

In the Joomla framework, models are responsible for managing the data. The first function that has to be 
written for a model is a get function. It returns data to the caller. For this example, the caller will be the 
HelloWorldViewHelloWorld view. By default, the model named HelloWorldModelHelloWorld residing in 
site/models /helloworld.php is the main model associated to this view. 

 

Q4.  Explain how to access a Joomla Component.      Mark-2 

First we need to access the Joomla! platform, which is always accessed through a single point of entry. 
Using your preferred web browser, navigate to the following URL: 

1. user access <yoursite>/joomla/index.php  

2. administrator access <yoursite>/joomla/administrator/ index.php 

You can use the URL of the component, or a Menu in order to navigate to the component. 

Hello World! example: localhost/joomla/index.php?option=com_helloworld 

 

Q5. Explain MVC Basic Directory Structure.        Mark-3 

Components are stored in a directory within your Joomla! installation, specifically at: 
htdocs/<path_to_joomla>/components/com_<component_nam e>/ .  

The Hello World! component would be stored in htdocs/<path_to_joomla>/components/ 
com_helloworld/.  

 

A basic component will contain the following files within its directoryː 

A html file that is just a security file with a background colorː index.html  

A php file that represents the controller itselfː controller.php  

A php file that loads the controller classː <component_name>.php 

A php file that represents the model itselfː models/<component_name>.php  

Another html file for background controlː models/index.html  

A php file containing the default viewː views/<component_name>/tmpl/default.php  

A xml file for adding a menu item typeː views/<component_name>/tmpl/default.xml Another html file for 
background controlː views/<component_name>/tmpl/index.html Another html file for background 
controlː views/<component_name>/index.html  

A php file for displaying the viewː views/<component_name>/view.html.php 
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Unit – 3 Modules (Part-2) 
 

Q1. What is joomla Modules?         Mark-2  

Simply put, a Joomla module is a block of code that pulls information from your website’s database or from 
Joomla components.  

Modules can be placed in any predefined module position included with a Joomla template. Modules are 
lightweight and flexible extensions used for page rendering. These modules are often “boxes” arranged 
around a component on a typical page.  

A well-known example is the login module.  

Modules are assigned per menu item, so you can decide to show or hide (for example) the login module 
depending on which page (menu item) the user is currently on.  

Modules are managed in the Joomla! Administrator view by the Module Manager. 

 

Q2. How to Install a Joomla module.        Marks-2 

All Joomla! extensions come in the form of compressed files and are installed via the Extension Manager.  

First, you need to login to the administrative area of your Joomla! website.  

Then, access the Joomla! Extension Manager by going to Extensions -> Extension Manager -> Upload 
Package File tab.  

Click the Browse button and select the module zip package on your local machine.  

Click the Upload File & Install button. 

There are some situations in which above procedure will not work. If you have an error in the installation, 
the two most common problems are:  

• The module was written for another, a older version of Joomla!  

• Problems with permissions and ownership of folders. The easiest way to solve permission problems is to 
use the FTP layer, which you set up in the Global Configuration. 

 

Q3. How to manage modules ?         Marks-3 

Modules are controlled by going to Extensions: Module Manager.  

To view it on the frontend it’s necessary to edit the module settings.  



  SHREE H. N. SHUKLA COLLEGE OF I.T. & MGMT. 
(AFFILIATED TO SAURASHTRA UNIVERSITY) 
 

   2 – Vaishalinagar    3 – Vaishalinagar  
   Nr. Amrapali Railway Crossing  Nr. Amrapali Railway Crossing 
   Raiya Road     Raiya Road 
   Rajkot – 360001    Rajkot - 360001 
   Ph.No–(0281)2440478,2472590   Ph.No–(0281)2471645 
 

 

 

122 

 

To access the Module Manager, log into your website as administrator and navigate to the Extensions tab 
and then Module Manager.  

Once you access the Module Manager, you can manipulate all modules on your website the way you like.  

Let us create a new module first. Click on the New button at the top-left corner of the screen.  

Select the module type from the available list. 

Edit the following options: Title - Enter a title for your new module. Module - Set the module as published, 
select template position for it, etc. 

Menu Assignment - Select the pages where the module should appear.  

Module Permissions - Set the permissions for the new module.  

Advanced - Set layout, caching options, tags, etc. 

When you are ready with the data for your new article, simply click on the Save & Close button to create it. 

 

Q4. What are Module Positions?         Mark-2 

A module position is a placeholder in a template.  

Placeholders identify one or several positions within the template and tell the Joomla! application where 
to place output from modules assigned to a particular position.  

The template designer has complete control over module positions, creating variations between templates 
and the respective Joomla! default positions assigned to modules in the installation sample data.  

For example, the module position Left could be defined to be on the left side of the template to display a 
site navigation menu.  

So if a module is assigned the Left position, it will be displayed wherever the designer puts that Left 
module position not necessarily the left side of the page. 

 

Q5. Explain Joomla! Default Modules.        Mark-5 

Joomla! is packaged with many modules, more are available on the JED (Joomla! Extension Directory). 

Archived Articles → This Module shows a list of the calendar months containing Archived Articles.  

Articles - Newsflash → The Newsflash Module will display a fixed number of articles from a specific 
category.  

Articles - Related Articles → This Module displays other Articles that are related to the one currently being 
viewed.  

Articles Categories → This module displays a list of categories from one parent category. Banners → The 
Banner Module displays the active Banners from the Component. Breadcrumbs → This Module displays 
the Breadcrumbs.  

Custom → This Module allows you to create your own HTML Module using an editor. 

Feed Display → This module allows the displaying of a syndicated feed.  
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Footer → This module shows the Joomla! copyright information.  

Language Switcher → This module displays a list of available Content Languages.  

Latest News → This Module shows a list of the most recently published and current Articles.  

Latest Users → This module displays the latest registered users.  

Login → This module displays a username and password login form.  

Menu → This module displays a menu on the frontend.  

Most Read Content → This Module shows a list of the currently published Articles which have the highest.  

Popular Tags → The Popular Tags Module displays the most commonly used tags. Random Image → This 
Module displays a random image from your chosen directory. 

Search → This module will display a search box.  

Similar Tags → The Similar Tags Module displays links to other items with similar tags. Smart Search 
Module → This is a search module for the Smart Search system.  

Statistics → The Statistics Module shows information about your server installation. Syndication Feeds → 
Smart Syndication Module that creates a Syndicated Feed for the page.  

Weblinks → This modules displays Web Links from a category defined in the Weblinks component.  

Who's Online → The Who's Online Module displays the number of Anonymous Users. Wrapper → This 
Module shows an iframe window to specified location. 

 

 

 

 

Unit – 3 Plugins (Part-3) 
 

Q1. What is plugin?           Mark-1 

A plugin is a kind of Joomla extension. Plugins provide functions which are associated with trigger events. 
Joomla provides a set of core plugin events, but any extension can fire events. This is a powerful way of 
extending the functionality of the Joomla Platform. 

 

Q2. How to install and enable plugin?        Mark-3 

Installation of additional plugins in Joomla is so easy. All you have to do after downloading the plugin you 
wish to install and go to your Joomla admin area -> Extensions -> Extension Manager.  

In the Upload Package File section click Browse and locate the archive of the plugin you wish to install. 
Then click Upload File & Install to upload the file and complete the installation. 
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Step 1. Login to your Login to your Joomla Admin area > Extensions > Extension Manager. Step 2. In 
Extension Manager: In the Upload Package File section click Browse, select the component file that you 
want to install; Click Upload File & Install to upload the file and complete the installation  

Step 3. Login to your Joomla Admin area > Extensions > Plugin manager  

Step 4. We are looking for in the list name similar to the name of your plugin as the plugin name and the 
name in the list of installed plugins may be different. Once you've found your set just plugin, put against his 
name, check mark and click on the button Enable.  

Step 5. Another option, enable the plugin is to click on his name and go to page of plugin settings. There, in 
the Enabled set to Yes. 

 

Q3. Explan Plugin Types.          Mark-5 

1. Authentication  

When somebody tries to login into Joomla, the Joomla application will need to authenticate this user. On 
most sites, authentication is performed against the Joomla database.  

This type of authentication is handled by the Authenticate - Joomla plugin.  

By using Authentication Plugins you can also use other external services to authenticate users.  

The Authentication - LDAP plugin, which allows authentication against a remote LDAP server. LDAP stands 
for Lightweight Directory Access Protocol and it allows for easy storage of name/value pairs in a tree-like 
system. 

2. Captcha 

In Joomla CAPTCHAs help protect your site from spamming by bots and other malicious actors.  

The CAPTCHA plugin, which protects your contact and registration forms against spam. There are several 
Joomla plugins available that add CAPTCHA support to a site.  

Some plugins require a fee, while others require registration. When you are done configuring the plugin, 
CAPTCHAs are now activated for your site. To test this, go to any of the following forms on your site: 

• Login registration form • Password reset form • Username reminder form • Contact form 

3. Content 

When an article is displayed in the Joomla frontend, a Content Plugin can be used to modify the articles 
content just before it is being displayed.  

In addition to this, a Content Plugin can also modify content just before it is saved to the database, or do 
something completely different just after the article was saved to the database. In general, if you want to 
hook into the content handling of Joomla, this plugin type is the one to use.  

When an article is loaded from the database to be shown in either the backend or the frontend, a Content 
Plugin can be used to alter that article in various ways.  

A Content Plugin can even be used to modify the editing form of the article! 
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4. Editor 

In both the Joomla frontend and the Joomla backend, a textbox can be turned into a complete WYSIWYG 
editor by using the field type editor.  

When this field type editor is shown, the Joomla Editor Plugin is called to display the chosen WYSIWYG 
editor on screen.  

Common WYSIWYG editors are TinyMCE, JCE, JCK Editor and ACE. It is important to differentiate between 
the Editor Plugin and the WYSIWYG editor.  

WYSIWYG editors are JavaScript based, providing an editing toolbar to content managers like Joomla. To 
make the WYSIWYG editor functional, additional code is used. 

5. Extensions 

The plugin group extension allows you to influence the behavior of Joomla when it is handling extensions 
(plugins, components, templates, libraries and modules).  

The Joomla core offers only one plugin in this group: The Extension – Joomla plugin. Whenever a Joomla 
extension is installed or removed (component, module, plugin, template, library, package), plugins of this 
group can hook into this event and do something.  

Within the Joomla CMS, extensions are installed using the Installation Manager and this backend 
component calls again for the JInstaller class within the CMS library. 

6. Finder  

Besides the regular Joomla search, there is also the Joomla com_finder component (dubbed as Smart 
Search).  

The main difference between the two is that com_search searches content real time (perhaps opening up 
many different database tables to make this happen), while com_finder creates index tables first and then 
only searches that index – which allows for more efficient (so it performs faster) full text searching.  

For each type of content, a separate Finder Plugin is required, just like with the regular search. 

7. Quick icon  

In the Joomla CMS, there are two Quick Icon plugins installed by default: one for Joomla core updates and 
one for Joomla extension updates.  

When enabled, they both display in the Control Panel of the Joomla Administrator in the module position 
icon.  

Both of the core plugins are more advanced. Instead of returning just a static array, they also add jQuery 
scripts to make an AJAX call that automatically updates the text of the button. 

8. System  

System Plugins allow you to hook into the behavior of the Joomla core application.  

A very common use case for a System Plugin is to modify the HTML code, before it is being sent to the 
browser - this is done by implementing the event method onAfterRender(). System Plugins also allow you 
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to re-route URLs to another component, modify the HTML header before it is being inserted into the 
Joomla template, and change the way that Joomla handles errors. 

9. User 

There are three plugins included in the Joomla CMS (User - Joomla, User - Profile and User - Contact 
Creator) of which the User – Joomla plugin is the most important.  

The User - Joomla plugin is responsible for logging in the user. It should normally not be disabled, unless 
another User Plugin completely takes over its functionality.  

It also offers automatic user creation (if enabled), sends registration mails and enables cookie logins.  

The User – Profile plugin can be seen as optional. It extends the regular Joomla user profile with additional 
fields, which can be activated through the plugins parameters in the Plugin Manager.  

The third core plugin User – Contact Creator automatically creates contact information for new users. 

 

Q4. Explain Plugin Events for each plugin type.       Mark-5 

When an event is thrown by Joomla, the event always specifies the plug-in group and the event method.  

If the event method exists as a class method within your plug-in, that method is called automatically.  

Depending on the event method, extra method arguments may be available. There are different events for 
a particular plug-in. 

1.  Authentication Plugins onUserAuthenticate : This event is triggered to verify that a set of login 
credentials is valid. 

2.  Captcha onInit : Event called to initialise the captcha. The other events are : onDisplay, onCheckAnswer 

3.  Content onContentPrepare : This is the first stage in preparing content for output and is the most 
common point for content orientated plugins to do their work. The other events are : onContentAfterTitle 
onContentBeforeDisplay onContentAfterDisplay onContentBeforeSave onContentAfterSave 
onContentPrepareForm onContentPrepareData onContentBeforeDelete onContentAfterDelete 
onContentChangeState onContentSearch onContentSearchAreas 

4.  Editors onInit : Event called to initialise the editor. The other events are : onSave onSetContent 
onDisplay onGetContent onGetInsertMethod 

5.  Extensions onExtensionAfterInstall : Event called to initialise the extension. The other events are : 
onExtensionAfterUninstall onExtensionAfterUpdate onExtensionBeforeSave onExtensionAfterSave 

6.  Finder onFinderCategoryChangeState : Event call when you change the category to find. The other 
events are : onFinderChangeState onFinderAfterDelete onFinderAfterDelete onFinderBeforeSave 
onFinderAfterSave 

7.  Quick Icons onGetIcons : This method is called when the Quick Icons module is constructing its set of 
icons. 
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8.  System onAfterInitialise : This event is triggered after the framework has loaded and the application 
initialise method has been called. The other events are : onAfterRoute onAfterDispatch onAfterRender 
onBeforeRender onBeforeCompileHead 

9.  User onUserAuthorisation : This event authorises that a particular user should be able to login. The 
system triggers this event after the user has been authenticated and before he has been signed in the 
website. 

The other events are : onUserAuthorisationFailure onUserBeforeSave onUserAfterSave 
onUserBeforeDelete onUserAfterDelete onUserLogin onUserLoginFailure onUserAfterLogin onUserLogout 
onUserBeforeSaveGroup onUserAfterSaveGroup onUserBeforeDeleteGroup onUserAfterDeleteGroup. 

 

Q5. Explan Custom Plugin Types and Events.       Mark-3 

1.  Contact Component 

onValidateContact : This event is triggered after a contact form has been submitted. 

The other events are : onSubmitContact 

2.  Installer Component 

onInstallerBeforeInstallation : This event is triggered before installation. 

The other events are : onInstallerBeforeInstaller onInstallerAfterInstaller 

3. Menu Component  

onAfterGetMenuTypeOptions : This event called when menu type selected. 

4. Module  

onRenderModule : This is an event that is called when a module on the front- or back-end is rendered. 

The other events are : onAfterRenderModule onPrepareModuleList onAfterModuleList 
onAfterCleanModuleList. 

 

 

 

 

 

Unit – 4 MVC Development (Part-1) 
 

Q1. What is MVC Development?         Mark-1 

In Joomla!, the MVC pattern is implemented using three classes: JModel, JView and JController. The classes 
JModel, JView and JController are now interfaces and the base abstract classes are now JModelBase, 
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JViewBase and JControllerBase, respectively. In addition, all classes have been simplified, removing a lot of 
coupling with the Joomla! CMS, that was unnecessary for standalone Joomla! Platform applications. 

 

Q2. Explain How to develop basic components in MVC.      Mark-3 

To create and install a basic Joomla! Component, we will be working with the Hello World! Component 
example. To begin, you must first use your preferred file manager to create a directory for the Hello World! 
component.  

This directory can be anywhere on your file system, as long as it outside of your Joomla! installation 
directory.  

For this example we will name the directory com_helloworld, but this directory can be named anything. 
Next, inside this directory we need to create some files. Using your preferred file manager, create the 
following files; as you create the files, add the source code for each file. 

1. helloworld.xml : this is an XML (manifest) file that tells Joomla! how to install our component.  

2. site/helloworld.php : this is the site entry point to the Hello World! component  

3. site/index.html : prevents web server from listing directory content  

4. admin/index.html : prevents web server from listing directory content  

5. admin/helloworld.php : this is the administrator entry point to the Hello World! component  

6. admin/sql/index.html : prevents web server from listing directory content  

7. admin/sql/updates/index.html : prevents web server from listing directory content  

8. admin/sql/updates/mysql/index.html : prevents web server from listing directory content  

9. admin/sql/updates/mysql/0.0.1.sql : file allowing to initialise schema version of the com_helloworld 
component. 

 

Q3. How to Install the Hello World! Component?      Mark-2 

Using your preferred file manager, create a .zip file of this directory.  

For this example we will name the file com_helloworld.zip, again this file could have been named anything.  

Now we need to install the Hello World! component.  

There are two ways to do this, both are covered in Installing an Extension. Here we will cover the method 
using the Extension Manager of Joomla!. Using your preferred web browser, navigate to the Administrator 
panel of your Joomla! site.  

The address would be <yoursite>/joomla/administrator/index.php. For this example we will navigate to 
localhost/joomla/administrator/index.php.  

Click Extensions → Manage → Install → Upload Package File → Choose File Navigate and Select File Click 
Upload & Install. 
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Q4. Explain adding a view to the site part.       Mark-3 

To add a view you will need to navigate to com_helloworld, which is the original directory we made for our 
component. Using your preferred file manager, create or update the following files; as you create or 
update the files, add the source code for each file. 

1. Update: helloworld.php <path_to_com_helloworld>/site/helloworld.php  

2. Create: controller.php <path_to_com_helloworld>/site/controller.php  

3. Create: index.html <path_to_com_helloworld>/site/views/index.html  

4. Create: index.html <path_to_com_helloworld>/site/views/helloworld/index.html  

5. Create: view.html.php <path_to_com_helloworld>/site/views/helloworld/view.html.php 6.Create: 
default.php <path_to_com_helloworld>/sites/views/helloworld/tmpl/default.php 

7. Create: index.html <path_to_com_helloworld>/site/views/helloworld/tmpl/index.html  

8. Update: helloworld.xml <path_to_com_helloworld/helloworld.xml. 

Q5. Explain adding a menu type to the site part.      Mark-3 

To add a menu item you will need to navigate to com_helloworld, which is the original directory we made 
for our component.  

Using your preferred file manager, create or update the following files; as you create or update the files, 
add the source code for each file. 

1.Create: default.xml  <path_to_com_helloworld/site/views/helloworld/tmpl/default.xml  

2. Update: helloworld.xml <path_to_com_helloworld/helloworld.xml 

After the component has been updated, we will be able to add a Menu Item to it.  

This will allow us to access our component a menu rather than having to remember what to type into the 
address bar.  

We'll do this using the Menu Manager of Joomla!. Using your preferred web browser, navigate to the 
Administrator panel of your Joomla! site.  

The address would be <yoursite>/joomla/administrator/ index.php. For this example we will navigate to 
localhost/ joomla/administrator/index.php.  

Add a new menu item by clicking on Menu → <existing menu> → Add New Menu Item.  

A new screen will appear. In the "Menu Title" field, enter "Hello World!" In the "Menu Type" field, click on 
the "Select" button and choose Hello World! → Hello World from the selection screen.  

Click Save & Close. 

 

Q6. Explain adding a model to the site part.       Mark-2  

To add a model you will need to navigate to com_helloworld, which is the original directory we made for 
our component. Using your preferred file manager, create or update the following files; as you create or 
update the files, add the source code for each file. 
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1. Create: helloworld.php <path_to_com_helloworld>/site/models/helloworld.php  

2. Create: index.html <path_to_com_helloworld>/site/models/index.html  

3.Update: view.html.php <path_to_com_helloworld>/site/views/helloworld/view.html.php  

4. Update: helloworld.xml <path_to_com_helloworld>/helloworld.xml. 

 

Q7. Explain adding a variable request in the menu type.     Mark-2  

It is possible to add parameters to menu types. For example, this is done in the 
site/views/helloworld/tmpl/default.xml file.  

The displayed message is always Hello World!. Including a type list field within the menu. This is one of the 
Joomla Standard Form Field Types. 

Two important things to note:  

1. The request group of fields indicates mandatory fields.  

2. The name attribute can be passed to the component in the URL. 

Modify your helloworld.xml file to indicate the new version. You can test this variable request by putting 
index.php?option=com_helloworld&view=helloworld&id=1 or 
index.php?option=com_helloworld&view=helloworld&id=2 in your browser address. 

 

Q8. Explain MVC component using the database.      Mark-2 

Components usually manage their contents using the database. During the install/uninstall/update phase 
of a component, you can execute SQL queries through the use of SQL text files.  

With your favorite file manager and editor create two files called admin/sql/install.mysql.utf8.sql and 
admin/sql/updates/mysql/ 0.0.6.sql.  

They should both have the same content. InnoDB is the more modern (and now default) MySQL database 
engine, replacing MyISAM, and utf8mb4 supports a wider range of character sets including emojis.  

The file install.mysql.utf8.sql will be executed when you install this component. The file 0.0.6.sql is 
executed when you do an update. 

 

Q9. Explain MVC basic backend.         Mark-2 

Designing the backend interface leads us to create at least a Model-View-Controller triangle.  

We have to modify the administrator entry point of our component, the admin/helloworld.php file. 

Create the general controller The entry point now gets an instance of a HelloWorld prefixed controller.  

This controller will display the 'HelloWorlds' view by default. 

Create the view With your favourite file manager and editor, create a file 
admin/views/helloworlds/view.html.php Views display data using layout.  
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With your favourite file manager and editor, put a file admin/views/helloworlds/tmpl/ default.php 

 

 

 

 

 

 

 

 

 

 

 

 

Unit – 4 Module Development (Part-2) 
 

Q1. Explain MVC Development.         Mark-1 

Modules are lightweight and flexible extensions.  

They are used for small bits of the page that are generally less complex and are able to be seen across 
different components.  

You can see many examples of modules in the standard Joomla! install: - menus - Latest News - Login form 
- and many more. 

 

Q2. Explain Module File Structure.        Mark-3 

There are four basic files that are used in the standard pattern of module development: 
mod_helloworld.php - This file is the main entry point for the module. It will perform any necessary 
initialization routines, call helper routines to collect any necessary data, and include the template which 
will display the module output.  

mod_helloworld.xml - This file contains information about the module. It defines the files that need to be 
installed by the Joomla! installer and specifies configuration parameters for the module.  

helper.php - This file contains the helper class which is used to do the actual work in retrieving the 
information to be displayed in the module (usually from the database or some other source).  

tmpl/default.php - This is the module template. This file will take the data collected by 
mod_helloworld.php and generate the HTML to be displayed on the page. 
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Q3. Explain how to create mod_helloworld.php.      Mark-2 

The mod_helloworld.php file will perform three tasks:  

• include the helper.php file which contains the class to be used to collect the necessary data  

• invoke the appropriate helper class method to retrieve the data  

• include the template to display the output. The helper class is defined in our helper.php file. This file is 
included with a require_once statement: 

require_once dirname(__FILE__) . '/helper.php'; 

require_once is used because our helper functions are defined within a class, and we only want the class 
defined once. 

The helper class method is invoked in the following way: $hello = 
modHelloWorldHelper::getHello($params); 

 

 

 

Q4. How to create helper.php.         Mark-2 

The helper.php file contains the helper class that is used to retrieve the data to be displayed in the module 
output.  

Our helper class will have one method: getHello(). This method will return the ‘Hello, World’ message.  

There is no rule stating that we must name our helper class as we have, but it is helpful to do this so that it 
is easily identifiable and locatable.  

Note that it is required to be in this format if you plan to use the com_ajax plugin.  

More advanced modules might include database requests or other functionality in the helper class 
method. 

 

Q5. How to create tmpl/default.php.        Mark-2 

The default.php file is the template which displays the module output. The code for the default.php file is 
as follows: 

<?php  

// No direct access defined('_JEXEC') or die;  

?> 

 

<?php  

echo $hello;  

?> 
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An important point to note is that the template file has the same scope as the mod_helloworld.php file. 
What this means is that the variable $hello can be defined in the mod_helloworld.php file and then used in 
the template file without any extra declarations or function calls. 

 

Q6. How to create mod_helloworld.xml.       Mark-1 

The mod_helloworld.xml is used to specify which files the installer needs to copy and is used by the 
Module Manager to determine which parameters are used to configure the module.  

Other information about the module is also specified in this file.  

Manifest files explains the technical details of the elements used in the XML file. 

 

 

 

 

 

 

Unit – 4 Plugin Development (Part-3) 
 

Q1. Explain Plugin Development.         Mark-1 

The plugin structure for Joomla! is very flexible and powerful. Not only can plugins be used to handle 
events triggered by the core application and extensions, but plugins can also be used to make third party 
extensions extensible and powerful.  

This provide you with the basics of what you need to know to develop your own plugin. Most plugins 
consist of just a single code file but to correctly install the plugin code it must be packaged into an 
installation file which can be processed by the Joomla! installer. 

 

Q2. How to create the installation file?        Mark-2 

As with all extensions in Joomla!, plugins are easily installed as a .zip file (.tar.gz is also supported) but a 
correctly formatted XML file must be included.  

<extension> tag and the extended information in the <filename> tag tells Joomla! into which folder to copy 
the file and to which group the plugin should be added.  

In creating a new plugin to respond to core events it is important that your plugin's name is unique and 
does not conflict with any of the other plugins that may also be responding to the core event you wish to 
service as well. 
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Q3. Explain how to create the plugin.        Mark-1 

The object-oriented way of writing plugins involves writing a subclass of JPlugin, a base class that 
implements the basic properties of plugins.  

In your methods, the following properties are available: $this->params: the parameters set for this plugin 
by the administrator $this->_name: the name of the plugin $this->_type: the group (type) of the plugin. 

 

Q4. Explain how to use plugins in the code.       Mark-2 

Now that you've created your plugin, you will probably want to call it in your code. 

In that case you don't need to do the following. If you want to trigger an event then you use code like this: 

$dispatcher = JDispatcher::getInstance(); $results = $dispatcher->trigger( '<EventName>', 
<ParameterArray> ); 

If you are creating a plugin for a new, non-core event, remember to activate your plugin after you install it. 
Precede any reference to your new plugin with the JPluginHelper::importPlugin() command. 

 

 

 

Unit – 4 Template Development (Part-4) 
 

Q1. Explain how to set up a directory structure in template.     Mark-2 

To make the most basic template, create a new folder in the templates folder. Name this folder after your 
template i.e. mynewtemplate.  

Using your favourite text editor create the files index.php and templateDetails.xml. To keep things 
organized, make 2 new folders called images and css. Inside the css folder create a file called template.css. 

This is the most basic practical setup. Outline of folder and file structure: 

*mynewtemplate/  

** css/  

*** template.css  

** images/  

** index.php  

** templateDetails.xml 

 

Q2. How to create a basic templateDetails.xml file?      Mark-3 

The templateDetails.xml file is essential. Without it, your template won't be seen by Joomla!.  

The file holds key metadata about the template. The syntax of the file is different for each Joomla version. 
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Example : 

<?xml version="1.0" encoding="utf-8"?>  

<extension version="2.5" type="template">  

<name>mynewtemplate</name>  

<creationDate>2018-05-01</creationDate>  

<author>Ram Sharma</author>  

<authorEmail>ram@example.com</authorEmail> 

<description>My New Template</description>  

<files>  

<filename>index.php</filename>  

<filename>templateDetails.xml</filename>  

<folder>images</folder>  

<folder>css</folder> 

</files>  

<positions>  

<position>breadcrumb</position>  

<position>left</position>  

<position>right</position>  

<position>top</position> 

 </positions>  

</extension> 

So, as you can see, we have a set of information between markup tags (the <element>s). The <files> part 
should contain all the files that you use.  

The <folder> element can be used to define an entire folder at once.  

The positions are a common set so you will be able to switch easily from the standard templates. 

 

Q3. Explain how to create a basic index.php file in template.     Mark-5 

The index.php file becomes the core of every page that Joomla! delivers.  

Essentially, you make a page (like any HTML page) but place PHP code where the content of your site 
should go.  

The template works by adding Joomla code into module positions and the component section in your 
template.  

Anything added to the template will appear on all pages unless it is added to one of these sections via the 
Joomla CMS. 
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→ Begin A Joomla template begins with the following lines: 

<?php defined( '_JEXEC' ) or die( 'Restricted access' );?>  

<!DOCTYPE html>  

<html xmlns="http://www.w3.org/1999/xhtml" xml:lang="<?php echo $this->language; ?>" lang="<?php 
echo $this->language; ?>" > 

The first line stops people looking at your coding and getting up to bad things.  

The second line is the Document Type Declaration (DOCTYPE), which tells the browser which flavor of 
HTML the page is using.  

The third line begins our HTML document and describes what language the website is in.  

A html document is divided into two parts, head and body.  

The head will contain the information about the document and the body will contain the website code 
which controls the layout. 

→ Head 

<head>  

<jdoc:include type="head" />  

<link rel="stylesheet" href="<?php echo $this->baseurl ?>/templates/system/css/system.css" 
type="text/css" /> 

<link rel="stylesheet" href="<?php echo $this->baseurl ?>/templates/system/css/general.css" 
type="text/css" />  

<link rel="stylesheet" href="<?php echo $this->baseurl ?>/templates/<?php echo $this->template; 
?>/css/template.css" type="text/css" />  

</head>  

The first line gets Joomla to put the correct header information in.  

This includes the page title, meta information as well as system JavaScript.  

The rest creates links to two system style sheets and to your own style sheet. 

→Body Section 

<body>  

<jdoc:include type="modules" name="top" />  

<jdoc:include type="component" />  

<jdoc:include type="modules" name="bottom" />  

</body>  

These lines, usually called jdoc statements, tell Joomla to include output from certain parts of the Joomla 
system. 

→ Module Positions  
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Above, the line which says name="top" adds a module position called top and allows Joomla to place 
modules into this section of the template.  

You can add your own module lines anywhere you want in the body, but you have to add a corresponding 
line to the templateDetails.xml file which sits alongside the index.php of your template. 

→ End  

Finish it off with : </html>  

→ Custom Images  

If you want to add any images to the template you can do so like this: <img src="<?php echo $this-
>baseurl; ?>/templates/<?php echo $this->template; ?>/images/myimage.png" alt="Custom image" 
class="customImage" />  

→ Custom CSS  

You can add custom css like this: <link rel="stylesheet" href="<?php echo $this->baseurl 
?>/templates/<?php echo $this->template;?>/css/styles.css" type="text/css" />  

Every file which is added must have a line in the templateDetails.xml file for the template. 

 

 

Q4. Explain how to test the template.        Mark-2 

Find the template in the Template Manager, select it and click Default to make it the default template.  

In the Joomla! 2.5 series and later, you first need to tell Joomla! that you have created a new template.  

This feature is called Discover Extensions and can be accessed via Extensions -> Extension Manager -> 
Discover. Click Discover to discover your template, then select it and click Install to install it.  

Now your template should show up in the Template Manager (Styles), accessible via Extensions -> 
Template Manager. 

 

Q5. Explain how to package the template for installation.     Mark-2 

A directory with several loose files is not a convenient package for distribution.  

So the final step is to make a package. This is a compressed archive containing the directory structure and 
all the files. The package can be in ZIP format (with a .zip extension).  

If your template is in a directory mytemplate/ then to make the package you can connect to that directory 
and use commands like: 

zip -r ..\mytemplate.zip *.* 
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Unit – 5 Advance Development (Part-1) 
Q1. Explain adding language management.       Mark-2 

Joomla manages languages for components in four different situations: 

- displaying a component in the public site  

- managing a component in the backend  

- managing menus in the backend  

- installing a component 

Joomla uses two different location folder for languages:  

- one in administrator/language or language  

- one in the component folder  

(administrator/components/*component*/language or components/*component*/language) 

It depends how the component is installed. 

 

Q2. How to add backend actions?        Mark-1 

Adding a toolbar In Joomla, the administrator interacts generally with components through the use of a 
toolbar.  
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In the file admin/views/helloworlds/view.html.php put this content. It will create a basic toolbar and a title 
for the component.  

The arguments used in, for example, JToolbarHelper::addNew is used to set a controller instance which will 
be used after button is clicked. You can find other classic backend actions in the 
administrator/includes/toolbar.php file of your Joomla installation. 

 

Q3. How to add decorations to the backend?       Mark-1 

Adding some icons With your file manager you can put a 16x16 image and a 48x48 image in a 
media/images/ folder and add a media tag in your install file. Modify the menu tag in order to use the new 
icon. 

 

Q4. How to add verifications?         Mark-2 

Joomla 1.5 and later versions contain a behavior, which allows your form and its elements to be validated 
at client side, i.e., before it is submitted to the server. The behavior enables the script validate.js 

The following classes are available: required validate-username validate-password validate-numeric 
validate-email validate-[custom] -> custom defined 

Joomla translates the required field attribute into a required class value. Forms can be verified on the 
client side using javascript code. Verifying the form on the server side is done by inheritance of 
JControllerForm class. 

Q5. How to add categories?         Mark-2 

Use of the Joomla Categories functionality to enable us to define a set of categories for use with any 
component.  

There are a number of ways to this: Modifying the SQL In order to manage categories, we have to change 
the SQL tables.  

With your editor, modify admin/sql/install.mysql.utf8.sql 

Modifying the form All messages can now belong to a category.  

We have to modify the editing form. In the admin/models/forms/yourfile.xml file. 

Modifying the menu type The menu type displays a drop down list of all messages.  

If the message is categorized, we have to add the category in this display. In the 
admin/models/fields/yourfile.php file 

Managing the submenu The com_categories component allows to set the submenu using a helper file. 

 

Q6. How to add configuration?         Mark-1 

The Joomla framework allows the use of parameters stored in each component.  

With your file manager and editor, put a file admin/config.xml file.  
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This file will be read by the com_config component of the Joomla core. Data now contains a new 
parameter: params.  

The SQL structure has to be modified. With your editor, update admin/sql/install.mysql.utf8.sql. 

 

Q7. How to add ACL Supporting plugins in your component?     Mark-3 

Adding Access Control With Joomla!'s Access Control we can define which user groups are allowed or 
denied to do which actions in your component.  

There are 2 actions that need to be defined at the component level for a Joomla! 2.5+ component to offer 
basic ACL support: 

Configure (core.admin): which groups are allowed to configure the component level permissions via the 
'Options' toolbar button? 

Access Component (core.manage): which groups are allowed to access the component's backend? 

Adding ACL Supporting plugins in your component 

This basic ACL support is done in 4 simple steps: 

- Add the 2 minimal component level actions to access.xml  

- Add the permissions fieldset to config.xml  

- Add the 'Options' toolbar button  

- Restrict the access to the component's backend 

 

Q8. Explain Joomla Observer Implementation.       Mark-2 

The event system in Joomla! allows for a flexible method for components, modules and plug-ins to 
communicate with other plug-ins by following the Observer pattern.  

This pattern is most easily described as a simple communication mechanism.  

Joomla! implements the Observer pattern at a global level through the JPlugin (Observer) and 
JEventDispatcher (Observable) classes.  

Anyone wanting to receive notification of events will create a plug-in that extends the JPlugin class. 

 

Q9. Why Become A communicator?        Mark-2 

There may be times in your component's lifecycle when it would be nice to notify others that some action 
has taken place.  

For example, let's say you have a compact disk (CD) library component. You may decide that you would like 
to let others know when a new CD has been added to the library.  

In this case, you could document a well known event (onCdAddedToLibrary for example) and at the 
appropriate time, trigger the event passing in information about the new CD that was added to the library. 
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Q10. How To Become A Communicator?        Mark-2 

It is easy to become a communicator. In fact, it's really just a matter of loading a certain set of plug-ins and 
calling the trigger method of the JEventDispatcher class.  

You may wonder how to know which set of plug-ins to load. Plug-ins are managed at a group level that is 
defined in the plug-in's XML deployment file.  

There are eight predefined plug-in groups and each plugin group is meant to handle a different set of tasks. 
For example, there is a search plug-in group that is meant to handle searching and a user plug-in group 
meant to handle user specific functions such as adding and removing a user from the Joomla! system.  

So you can create your own plug-in group and call it whatever you want. 

 

Q11. How To Trigger Events ?         Mark-2 

How to trigger events so implementing plug-ins can act on them.  

The first thing you need to do is to load your plug-in group. This is done via the following code: 
JPluginHelper::importPlugin( 'myplugingroup' ); This will load all enabled plug-ins that have defined 
themselves as part of your group.  

The next thing you need to do is get an instance of the JEventDispatcher class: $dispatcher = 
JEventDispatcher::getInstance();  

Next, we need to trigger our custom event: $results = $dispatcher->trigger( 'onCdAddedToLibrary', array( 
&$artist, &$title ) ); 

 

Q12. Explain Caveats (Important Notes).        Mark-2 

You Are Defining An API By offering events for plugins to respond to, you are effectively creating an API. 
Proper planning is extremely important  

– once you release your code, other developers will start to depend on your events' names and 
parameters.  

Changing them later will break compatibility with all the plugins that use them. 

Load The Right Plugin Group One thing to notice about the trigger method is that there is nothing defining 
which group of plug-ins should be notified.  

In actuality, all plug-ins that have been loaded are notified regardless of the group they are in. 

Caveats (Important Notes) It's important to make sure you have an event name that does not conflict with 
any other plug-in group's event name.  

Most of the time this is not an issue because your component is the one that is loading the plug-in group, 
so you know which ones are loaded. 
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Unit – 5 Joomla Framework (Part-2) 

 
Q1. What is the joomla Framework?        Mark-1 

The Joomla! Framework is a new PHP framework (a collection of software libraries/packages) for writing 
web and command line applications in PHP, without the features and corresponding overhead found in the 
Joomla! Content Management System (CMS).  

It provides a structurally sound foundation, which is easy to adapt and easy to extend. The Joomla! 
Framework is free and open source software, distributed under the GNU General Public License version 2 
or later. 

 

Q2. How to get the Sample Application?        Mark-2 

The new Joomla! Framework is now available to install via Composer and you can find the list of packages 
on Packagist.org. 

One of the easiest ways to get to know the Joomla! Framework is to start with looking at a sample 
application. This site is powered by the Joomla! Framework and serves as a great example of using the 
Framework. 

- Install Composer. - Download this website application repository from GitHub. - Run composer install. - 
View in your browser. 

 

 

Q3. Why build a joomla Framework?        Mark-1 

Separating the framework from the CMS was a big deal, and a smart decision.  

By separating the two code bases Joomla! can now offer the stability the CMS requires while still taking 
advantage of current and modern trends in PHP development. 

 

Q4. What is the Framework good for?        Mark-1 

Building a restful web services platform.  

Building both simple and complex command line tools.  

Building next generation web applications. A great example is the issue tracker for the Joomla! CMS. 

 

Q5. Explain Framework Architecture.        Mark-3 

The Joomla! Framework has also been designed for maximum flexibility.  
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Breaking the Framework into isolated modular packages allows each package to evolve more easily than if 
all packages are tied to a single, large package release.  

Gone are the days when a PHP framework must offer anything and everything a developer needs to 
complete a project.  

The current and widely adopted modern practice is to employ lightweight independent feature-specific 
packages. The Framework is distributed with Composer, and as such, allows you to include any other PHP 
code packages that you can install using Composer.  

Take a look at Packagist.org to see the kind and quality of code which becomes available when using 
Composer for dependency management. 

 

Q6. What does the joomla Framework mean for you?       Mark-1 

Whether you are a Joomla! extension developer looking to spread your wings & delve into developing 
standalone applications or a PHP coder looking for a stable lightweight framework for your next app, the 
Framework provides benefits for everyone. 

 

Q7. Why should i consider using the joomla Framework?     Mark-1 

It's important to keep in mind other situations, such as what happens when you land a project that needs a 
different type of application.  

Or when something doesn't really fit into the website or CMS box, or the CMS is simply too much 
overhead.  

There may be times when you need a simple tool to migrate data from one Business Intelligence system to 
another or a lightweight restful service to talk to a mobile application.  

These are all cases when a framework-based application will prove much more beneficial. 

Q8. I know php already why should u use this Framework?     Mark-1 

If you are a strong coder looking for a lightweight framework that is easy to adapt and extend, you are in 
the right place.  

The Joomla! Framework is available using Composer.  

This allows you to build projects from the many packages included in the Joomla! Framework as well as 
packages that best fit your needs from any of the other PHP frameworks that use Composer. 

 

Q9. As a joomla CMS User how will i be affected?      Mark-1 

The Joomla! CMS and the Joomla! Framework are currently developed independently and, thus, the 
Framework's launch will not have an immediate impact for you. However, there are already parts of the 
Framework integrated into the CMS and more is coming.  

Expect to see some great extensions made available to you, built using the Framework! 
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Unit – 5 Joomla 4 & Future (Part-3) 

 
Q1. What is joomla 4 ?          Mark-2 

We are firmly committed to making the next generation of Joomla the best generation! Joomla 4 intends 
to deliver more simplicity and a better experience for users and a more powerful system for developers. 
Here’ a short list of Joomla 4 key features and benefits we intend to implement: 

→ A cleaner and more powerful codebase with the removal of deprecated functions from Joomla 3.x and 
the use of PHP namespaces that allows developers to deliver more robust and innovative applications than 
ever before.  

→ Install Joomla in the blink of an eye: an easiest, fastest and more user friendly install process.  

→ Brand new User Interfaces (backend and frontend) to provide a new and easiest experience, using 
Bootstrap 4. 

→ The power of the Joomla Framework merged to the 

CMS . 

→ A fully rebuilt Media Manager with a cleaner User Interface and new image editing features . → New 
security features such as support for prepared SQL statements An enhanced event dispatching system. 

 

 

 

 

Q2. Why the transformation in Joomla 4?       Mark-2 

Though Joomla has been improving through the time, Joomla however is based on 10 years old 
technologies. So, it can’t respond to many modern technologies. It’s like an old-fashioned Joomla.  

You may defend that there are many people still using it, but please take note that there are not so many 
new users and new Joomla users from the market hasn’t been expanding.  

Furthermore, the outdated technologies prevent developers from doing many things to build great 
projects with it. So, Joomla must transform to catch up with the modern technology and be more 
responsive to the need of its users. 

 

Q3. Explain improvements in Joomla admin workflow.      Mark-1 

The development team has been working on a new and useful Joomla admin dashboard.  
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It’s the very first thing users see after logging in the admin area so they are trying to make it better for 
users with useful, relevant information right in the dashboard.  

Also there will be new onboarding process to help new Joomla users become familiar with Joomla much 
easier. 

 

Q4. Explain an evolution in Joomla code.       Mark-1 

Coding improvements in Joomla 4 will make you dance on your feet, Code in Joomla core will be more 
testable (so less bugs, of course) and easier to maintain.  

I can list out some improvements in coding you can expect in this awesome version: a new rewritten plugin 
system, Dependency Injection Containers to replace JFactory, Joomla framework to be used in more 
components (so less code to maintain later), Code Namespacing. 

 

Q5.  Explain Orthogonal Component Structure.       Mark-1 

Joomla 4 structure is the combination of vertical components like content or users and horizontal 
components like workflow, tagging, versioning. This means while we have the development in Joomla core, 
at the same time all the new features regarding functionality like publishing, tagging and versioning, etc. 
will be added automatically in Joomla and all are configurable. 

 

Q6. Explain Strict MVC Implementation.        Mark-2 

“For Joomla 4, we restrict the duties of a component.  

So a component is asked to only implement its own core functionality. Everything else is pulled out into the 
system”.  

So there will be much less codes extension developers have to write! Internally, they will use “command 
bus” to oversimplify extend the functionality where we have a single yet multitask controller.  

The way Joomla 4 is applied the MVC will define the orthogonal component structure and how it works. 

Q7. Explain Frontend and Backend Template Improvements using Bootstrap4.  Mark-2 

Modern Admin is nothing else than a contemporary Bootstrap dashboard template.  

It is entirely flexible, extensible and adaptable to fit your online project to the single smallest detail.  

In the pack, you will find seven predefined layouts for a broad specter of users and needs.  

Everything is organized and commented to perform any additional improvements and customization 
smoothly.  

In the Modern Admin package, there are over 1500 pages, more the one thousand components and lots of 
other features and elements. 
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